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C H A P T E R  1  
 _____________________________________________________________________________________________ 

Getting Started _____________________________________________________________________________________________  
 
 

1.1  Overview 
 
F-Chart is a computer program useful for the analysis and design of active and passive solar 
heating systems.  The program is an implementation of methods developed at the University of 
Wisconsin Solar Energy Laboratory to estimate the long-term average performance of: 
 
•  Domestic Water Heating Systems 
•  Pebble Bed Storage Space and Domestic Water Heating Systems 
•  Water Storage Space and Domestic Water Heating Systems 
•  Active Collection with Building Storage Space Heating Systems 
•  Direct-Gain Passive Systems 
•  Collector-Storage Wall Passive Systems 
•  Pool Heating Systems 
•  General Solar Heating Systems (e.g., process heating systems) 
•  Integral Collector-Storage Domestic Water Heating Systems 
 
Weather data for hundreds of North American locations, the 16 California climate zones and 
numerous other locations are included with the program.  The user can add new weather data. 
 
The easiest way to become acquainted with F-Chart is to try an example problem using the 
default parameters supplied with the program.  F-Chart conforms to the Windows standard 
interface and can be run with a minimum of instructions.  After you have become familiar with 
the program, you may wish to review the detailed program instruction set in Chapter 2 and the 
collector, system and economic parameter set descriptions in Chapters 3, 4, and 5. 
 
When you start F-Chart (click on the file FCHART.EXE), a header will appear showing the 
version number, registration number, and your company information.  To proceed, click OK.  
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After clicking the mouse button, the header will disappear and three windows containing the 
collector, system and economic parameters of the default system will appear.  The default system 
is a pebble bed space and domestic water heating system with a flat-plate collector.  (It is 
possible to change the default system to your specifications, as described with the Save as 
command in the next chapter.)  Before changing any of the values, let's look at the available 
commands. 
 
Commands are distributed among nine pull-down menus.  Detailed descriptions of each of the 
commands can be found in the next chapter.  A brief summary follows. 
 

 
 
The File menu provides commands for loading and saving work files and printing information. 
 
The Edit menu provides for the usual Windows Cut, Copy and Paste commands as well as 

providing for the specification of multiple (e.g., monthly) values of highlighted parameters. 
 
The Preferences menu commands allow specification of the unit system (English or SI) and the 

visibility of the economics parameter window. 
 
The System menu contains the commands to select the type of solar system that is to be 

analyzed. 
 
The Collector menu allows specification of the type of solar collector array. 
 
The Data menu shows the locations for which weather data are available as well as commands to 

view, change, or add weather data. 
 
The Run/Plot menu contains commands to run a specific system or to run multiple calculations 

for a range of values of a specific parameter.  Plotting capabilities are also provided. 
 
The Window menu brings selected windows to the front and determines how windows are 

arranged. 
 
The Help menu provides on-line help as well as access to the manual.  Help is available for most 

menus, commands and parameters by highlighting the object and pressing F1. 
 
To select a command, place the cursor on the desired menu title, press the mouse button, and 
while holding the button down, slide the cursor to the command you wish to execute; then let up 
the mouse button.  Help is available for all commands in the Help menu.  Many of the menu 
commands have keyboard equivalents that are indicated in the menus.  For example, the Print 
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command in the File menu, which prints all information for the work session, can be issued by 
entering Ctrl+P.  Menus (or commands within a menu) that are not presently accessible are 
dimmed.  Dimmed items cannot be selected.    
 
 
1.2 Example 
 
Each system is described using three sets of parameters: the collector, the system and the 
economics sets.  All three sets are shown at the start of the program.  The economics parameter 
set will be in front and it will appear as follows: 
 

 
 
Depending on the screen size, the entire economics window may or may not fit on the screen.  
When the entire window cannot be displayed, the window will be provided with a scroll bar 
along the right hand side, as indicated above.  Use of the scroll bar is needed to view the entire 
window.  The operation of the scroll bars is the same as in any Windows application.  The 
indicator, represented by the sliding box, can be controlled in three ways.  It can be moved 
incrementally in either direction by clicking on the arrows.  Holding the mouse button down 
while the cursor is positioned over the arrows causes a continuous slow scroll.  The indicator can 
be moved up and down in large discrete amounts by clicking in the gray area above or below the 
indicator box.  By placing the cursor on the indicator box and holding the mouse button down, 
the indicator can be dragged to any desired position. 
 
Move the cursor to any exposed position on the Pebble-Bed Storage system window and click 
the mouse button to bring this window to the front.  The default system parameters for the pebble 
bed system are: 
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Note that the rectangular boxes for the last four parameter values are filled in with shading and 
no values are displayed.  These four parameters are applicable only if Duct losses are considered 
in the calculation.  Clicking the mouse in the box for Duct losses toggles the display from No to 
Yes and will uncover the duct loss parameters.   
 
To move the collector parameter window to the front, place the cursor anywhere on the collector 
window and click the mouse button (or issue the Collector Parameters command from the 
Window menu).  The default flat-plate collector parameter window will appear as: 
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There are several other window controls that you should be aware of.  The title bar at the top of 
the window displays a title indicating the window's contents.  When the window is active (i.e., 
the front window) the title bar will be displayed in color.  The title bar serves as a handle should 
you wish to move the window.  Move the cursor to a position within the title bar and press and 
hold the mouse button while dragging the window to a new position.  At the right corner of the 
title bar is a small box with an X referred to as the 'go-away' box.  Clicking the mouse button 
while the cursor is positioned in the go-away box will cause the window to be removed from 
view.  The other two small boxes will minimize or maximize the window.  The vertical size of 
any of the windows can be changed by moving the cursor to the lower right corner of the 
window and holding the mouse button down while dragging the mouse up or down to make the 
window longer or shorter.  
 
Select Calculate from the Run/Plot menu (or enter F2) to initiate the calculations for this system 
in Madison, Wisconsin.  When the calculations are completed, two new windows will appear 
showing the performance and economics results.  The economics output window will be in front 
and by default, it will display a summary of the economic calculations.  More detailed economic 
results, including a year-by-year cash flow analysis, can be obtained by changing the first 
parameter in the economics window. 
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Move the cursor to an exposed portion of the Thermal Output window to bring it to the front.  
 

 
 
The system or economics parameters can easily be changed to determine the effect of alternative 
designs.  For example, let's determine the performance for an array of 40 collector panels.  Click 
on an exposed portion of the collector parameter window to bring it to the front.  You may first 
want to use the Stack command in the Edit menu to organize the windows on the screen so that 
all of the title bars are visible.  Now move the mouse to position the cursor just after the 6 in the 
edit box for the Number of collector panels and double-click the mouse.  The line for which 
changes are being made will now be highlighted (i.e. displayed in inverse). 
 

 
6 
 



 
Chapter 1 

 

 
 
Now enter 40 for the number of collector panels.   
 

 
Select the Calculate command to repeat the calculations.  Both the Thermal and Economic 
Output windows will be updated.  The Thermal Output window will now appear like this: 
 

 
 
Notice the non-intuitive results.  Although the array area was increased by 54% from 26 to 40 
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panels, the fraction of the load supplied directly by the system increased only from 58.4% to 
71.5%! 
 
There is another way to examine the effect of a parameter such as array area on the system 
performance and economics.  The Parametric Plot command in the Run/Plot menu produces a 
plot of the solar fraction and/or the life-cycle savings as a function of many of the parameters.  
For example, let's plot of solar fraction and life-cycle savings as a function of number of 
collector panels.  We need to bring the collector parameters window to the front; but there are so 
many windows on the screen, it is difficult to see the collector parameters window.  An easy way 
to bring the window to the front is to select Collector Parameters from the Window menu.  
Clicking on Number of collector panels in the collector window will cause the cursor to flash on 
this parameter.  Now select Parametric plot from the Run/Plot menu.  A dialog box will appear 
in which you enter low and high values for the Number of collector panels and the number of 
points for which calculations are to be made.  Enter 10 and 50 respectively with No. of points 
equal to five.  The dialog box should now appear like this. 
 
 

 
 

When the Ok button is clicked, F-Chart will initiate calculations using five values of Number of 
collector panels ranging between 10 and 50 (in this case, 10, 20, 30, 40, and 50 panels).  If the 
Smooth Curves box is checked, a spline curve will be fit through the points.  A check in the Life-
Cycle Savings box will result in a plot of the savings as well as the solar fraction.  When the 
calculations are completed, the plot will appear in a separate window on the screen.  It is clear 
from the plot that the maximum life-cycle savings occurs with about 17 panels and the 
corresponding solar fraction is about 43%.   
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The look of the plot can easily be changed.  Double click on the plot and you have access to and 
can change many of the plot attributes. 
 
Most of the system parameters may assume monthly values.  For example, suppose you wish to 
consider the advantage of adjusting the slope of the collector at monthly intervals.  The optimum 
slope for any month will be the latitude plus the average solar declination for that month.  
(Average monthly declinations are given in Table 1.6.1 of Duffie and Beckman [1991].)  To 
assign monthly values to the collector slope (or to change the values), place the cursor on the 
Collector slope parameter; and select Monthly from the Edit menu (or alternatively, press 
Ctrl+M) and a dialog box will appear showing the monthly values which, by default, are all 
equal to 45 degrees.  Enter the following optimum values. 
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Click the Ok button when the values are entered.  The dialog box will disappear and the system 
parameter window will be in front.  The edit box for Collector slope now contains the word 
"Monthly" to indicate that this parameter has monthly values.  You can change or view the 
values at any time by clicking the mouse button when the cursor is on the parameter. 
 

 
 

Now pull down Calculate from the Run/Plot menu (or enter F2) to determine the increase in 
performance resulting from monthly orientation changes. 
 
The contents of a window can be on the Clipboard using the Copy Window command in the Edit 
menu (or enter Ctrl-A).  Any of the output appearing on the screen can be printed.  Select Print 
from the File menu (or enter Ctrl+P) to bring up the Print dialog box.   
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If a check appears in the box, the item following the checkbox will be printed.  (A dimmed item 
cannot be printed because it does not exist)  To select or unselect an item, move the cursor to the 
appropriate check box and click the mouse button.  By default, the output will go to the printer.  
Click the Print button to initiate the printing process.  Following the traditional Windows 
operating practice, different printers can be selected using the Printer Setup option in the File 
menu. 
 
You have now seen how the program is structured, how to select a system, change parameters 
and do the calculations.  Try running another example.  Don't forget the help feature.  Help is 
available for most menus, commands and parameters by highlighting the object and pressing F1.  
The manual often provides additional information. 
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C H A P T E R  2  
 _____________________________________________________________________________________________ 

Commands _____________________________________________________________________________________________  
 
 

2.1  Working with Menus 
 
Commands are distributed among nine pull-down menus appearing at the top of the screen.   To 
select a command, place the cursor on the desired menu title, press the left mouse button, and 
while holding the button down, slide the cursor to the command you wish to execute; then let up 
the mouse button.  Many of the menu items have command key equivalents.  That is, they can be 
executed either by using the mouse or by pressing the Ctrl key followed by the appropriate letter 
or number as shown to the right of the command in the pull-down menus.  
 
 
2.2  Changing Parameter Values 
 
The information needed to describe a system is contained in the system, collector, and economic 
parameter windows.  To change the values of these parameters, move the cursor to the 
rectangular box containing the value and left click the mouse button.  The cursor will flash in the 
box to indicate that it is the active parameter.  Use the backspace key or drag the cursor to erase 
characters to the left of the flashing cursor.  Characters entered from the keyboard are placed to 
the right of the indicator.  A double click within the edit box will cause all of the characters in 
the edit box to be highlighted (i.e., displayed in inverse video).  Pressing any key will replace the 
highlighted field with the character being typed.  All parameter values are checked after they are 
entered.  F-Chart will immediately inform you of an improper parameter with an appropriate 
error message. 
 
 
2.3  Dialog Boxes 
 
Many of the menu commands such as Change/View Load, will produce a dialog box in which 
you must supply information. Information which you can change is enclosed within a small 
rectangular edit box.  Default values, if available, will be displayed.  Values can be changed in 
the same manner as described for parameter values.  Click the Ok button to accept all of the 
changes.  Click cancel to disregard all changes. 
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2.4  Using Scroll Bars 
 

 
 
Many of the F-Chart windows are equipped with vertical and horizontal scroll bars that allow the 
contents of a window that is larger than the screen to be viewed.  The operation of the scroll bars 
is as follows.  The indicator position, represented by the small box, can be controlled in three 
ways.  It can be moved either direction by clicking on the arrows.  Holding the mouse button 
down while it is positioned over the arrows causes a continuous slow scroll.  The indicator can 
be moved up and down in large discrete increments by clicking in the gray area above or below 
the indicator box.  By placing the cursor on the indicator box and holding the mouse button 
down, the indicator can be dragged to any desired position. 
 
 
2.5  Menu Command Descriptions 
 
The remainder of this chapter provides detailed descriptions of each of the menu commands, 
Menu names will be shown in bold.  Command names appearing in the menus will be shown in 
italics.  All of the information presented here is available in the on-line Help menu. 
 
2.5.1 The File Menu 
 

 
 
Open will allow you to access and continue working on any file saved previously with the Save 

or Save as commands.  After the confirmation for unsaved work, a dialog box will appear 
showing the names of all previously saved F-Chart files in the current folder.  Other folders 
can be accessed in the normal Windows manner.  Select a file by clicking the mouse button 
on the file name followed by a click on the Open button or alternatively, by double-clicking 
on the file name.  When an old file is opened the screen will return to the state it was in when 
the file was saved.  The nine most recently saved files are listed at the bottom and can be 
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opened by double-clicking on the desired file. 

 
Save will store all of the information in your work session on the disk with the same file name 

and on the same disk drive with which it was last saved.  For a new work session, you will be 
prompted to supply a file name, just as if the Save as command were given.  All information 
concerning the work session is saved on the disk, except the output.  The stored information 
includes any changes you may have made to the meteorological data and the load.  The Save 
menu item is deactivated (i.e., dimmed) after the save operation until a change is made.  

 
Save as provides the same function as the Save command except that it will first prompt you to 

supply a file name.  This command allows you to save the work session with another name or 
in another folder than used previously.  A dialog box will appear in which you must supply a 
file name.  Enter the file name of your choice in the box.  The file name may have spaces, but 
should not contain a colon.  The extension FC will be added automatically.  Click the Save 
button when the name and drive are correct.  Each time F-Chart is started, a default file 
called DEFAULTS.FC is brought up.  If you wish, you can change this default file by setting 
up the parameters windows as you like and then saving it with the name DEFAULTS.FC in 
the folder where FCHART.EXE is located. 

 
Print will allow printing of the contents of any window to a printer.  A dialog box will appear 

with a number of check boxes on the left.  If a box is checked, then the item it represents will 
be printed.  To enter or remove a check mark, move the cursor to the box and click the mouse 
button.  Dimmed items cannot be printed because they do not exist.  Click Ok to start the 
print process.   
 
To send output to a disk file rather than a printer, go to the Windows Start menu and select 
Settings and then Printers.  Choose to add a printer.  A dialog box will appear and choose 
local printer.  When asked for the printer port, choose File and then use ‘Generic/Text only’ 
for the printer driver.  In order to print to a text file, choose the ‘Generic/Text only’ printer in 
the Printer Setup command 
 

Printer Setup brings up a dialog where you may choose your printer.  This command need be 
given only once, provided that the same printer is used throughout the work session. 

 
Quit command provides a graceful way to exit the program.  
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2.5.2 The Edit Menu 
 

 
 

Cut, Copy and Paste perform the normal Windows functions. 
 
Monthly allows a parameter to assume monthly values.  To enter multiple values for a 

parameter, select the parameter by clicking the mouse button on the parameter value.  If 
multiple values for this parameter are supported, the Monthly menu item in the Edit menu 
will be active (i.e., not dimmed).  Select the Monthly item from the Edit menu (or use 
Ctrl+M).  A dialog box will appear, showing the default values of the parameter.  These 
values may be edited in the usual manner.  The dialog box has three buttons.  The Cancel 
button returns the program to the state it was in before the Monthly command was issued.  
The Constant button causes the parameter to assume a single constant value equal to the first 
value displayed, e.g., the January value.  Pressing Ok will result in the parameter being 
associated with the displayed values.  The word "Monthly" will be displayed in place of the 
parameter value.  To edit multiple values, click on "Monthly".  A maximum of seven 
monthly varying parameter values are allowed.  

 
Copy Window places a copy of the active window on the clipboard.  The clipboard information 

may be pasted into other programs such as word processors, spreadsheets or presentation 
software. 

 
2.5.3  Preferences 
 

 
 

SI and English control the unit system in which parameter values are entered.  The currently 
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selected unit system is indicated by a check mark in front of SI Units or English Units in the 
menu.  The unit system can be changed at any point.  All system information, including the 
weather data will be converted to the new unit system.  You can use F-Chart to automatically do 
unit conversions by changing the unit system to that for which you know the parameter value, 
entering the value, and then changing back to the original unit system.   

 
Economics On and Economics Off control the visibility of the economics parameter set.  By default, 

the economics parameter window is visible.  To remove the economics window from view and to 
thereby bypass the economic calculations, select Economics Off.  To make the economics 
window visible (or to move it in front of all other windows), select Economics On.  The 
economics parameters remain at their current values whether or not the economics window is 
visible.  However, the economics calculations will be done only when the economics parameter 
window is visible. 
 
2.5.4  System 
 

 
 
Active Domestic Hot Water will open the parameter window for an active solar domestic hot 

water system.  The system consists of a solar collector, optional freeze protection heat 
exchanger, and either one or two storage tanks.  If a different system window is open at the 
time this command is issued, it will be closed and removed from view (with its parameters 
values retained).  If the active domestic hot water window is already open, this command will 
cause the active domestic hot water system window to be moved in front of all other 
windows. 

 
Pebble-Bed Storage Space & DHW will open the parameter window for a pebble-bed system.  

The pebble bed system is a space heating system (using air or liquid solar collectors) in 
which thermal energy is stored in heated pebbles.  A combined space and domestic hot water 
system can be analyzed.  If a different system window is open at the time this command is 
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issued, it will be closed and removed from view (with its parameters values retained).  If the 
pebble-bed window is already open, this command will cause the pebble-bed system window 
to be moved in front of all other windows. 

 
Water Storage Space & DHW will open the parameter window for a solar space and domestic 

water heating system in which thermal energy is stored in a water tank.  The system can be 
configured for just domestic water heating by setting the building UA to 0.  If a different 
system window is open at the time this command is issued, it will be closed and removed 
from view (with its parameters values retained).  If the water storage window is already open, 
this command will cause the water storage system window to be moved in front of all other 
windows. 

 
Building Storage will open the parameter window for a solar space heating system that does not 

have its own thermal storage unit.  When sufficient solar energy is available, energy is stored 
in the building structure by raising the indoor temperature above the low thermostat set 
temperature.  A combined space and domestic hot water system can be analyzed.  In this 
case, the presence of a water storage preheat tank is assumed.  If a different system window 
is open at the time this command is issued, it will be closed and removed from view (with its 
parameters values retained).  If the building storage window is already open, this command 
will cause the building storage system window to be moved in front of all other windows. 

 
Passive Direct Gain will open the parameter window for a direct-gain passive solar space 

heating system.  A direct gain system is essentially a window that allows solar energy to 
enter and be stored with the building structure by raising the indoor temperature above the 
low thermostat set temperature.  If a different system window is open at the time this 
command is issued, it will be closed and removed from view (with its parameters values 
retained).  If the direct gain window is already open, this command will cause the direct gain 
system window to be moved in front of all other windows. 

 
Passive Storage Wall will open the parameter window for a collector-storage wall passive solar 

space heating system.  In this system a masonry wall is used to absorb and store incident 
solar radiation that is later released within the building.  If a different system window is open 
at the time this command is issued, it will be closed and removed from view (with its 
parameters values retained).  If the collector-storage window is already open, this command 
will cause the collector-storage system window to be moved in front of all other windows. 

 
Pool Heating will open the parameter window for a solar pool heating system.  Both indoor and 

outdoor pools can be analyzed.  If a different system window is open at the time this 
command is issued, it will be closed and removed from view (with its parameters values 
retained).  If the pool system window is already open, this command will cause it to be 
moved in front of all other windows. 
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General Heating System will open the parameter window for a general solar energy system.  

The general solar energy system can be either a closed or open-loop solar energy designed to 
supply thermal energy above a specified temperature.  It can represent a space heating water 
heating, absorption air conditioning, or process heating system.  If a different system window 
is open at the time this command is issued, it will be closed and removed from view (with its 
parameters values retained).  If the general system window is already open, this command 
will cause it to be moved in front of all other windows. 

 
Integral Collector-Storage will open the parameter window for an integral collector-storage  

(ICS) domestic water heating system.   The ICS system combines the collector with the water 
storage unit.  The analysis method requires test data from the SRCC test method.  If a 
different system window is open at the time this command is issued, it will be closed and 
removed from view (with its parameters values retained).  If the ICS system window is 
already open, this command will cause it to be moved in front of all other windows. 

 
2.5.5  Collector 
 

 
 
The Collector menu can be accessed only after a system type has been chosen.  The passive 

direct gain, collector storage wall and ICS systems do not require a collector specification.  
The currently selected collector type is indicated by a check mark in the Collector menu.  If 
a different collector window is open at the time when a Collector menu command is issued, 
it will be closed and removed from view (with its parameters values retained) and replaced 
by a new window with the selected collector type.  If the same collector type is selected, the 
command will cause the collector window to be moved in front of all other windows.  

 
Flat-Plate will open the parameter window for a flat-plate solar collector.  The collector may be 

used with air or liquid.  Collector performance is described using ASHRAE 93-77 test 
results.   

 
Evacuated Tube will open the parameter window for an evacuated tube collector.  Evacuated 

tubes are modeled in the same manner as flat-plate collectors, with the exception that 
incidence angle modifiers may be specified for the planes parallel and perpendicular to the 
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tube axis.  The collector may be used with air or liquid.   

 
Compound Parabolic will open the parameter window for a compound parabolic concentrating  

(CPC) solar collector.  The collector may be used with air or liquid.  CPC collectors are 
modeled in a manner similar to evacuated tubes except that beam radiation can be utilized 
only if it is within the collector acceptance angle.   

 
1-Axis Tracking will open the parameter window for a solar collector that can track the solar 

position by rotation about a single axis.  The axis may be horizontal (as in east-west and 
north-south orientations) or tilted as in a polar axis orientation.  The tracking collector may a 
flat-plate or a concentrator.   

 
2-Axis Tracking will open the parameter window for a solar collector that can track the solar 

position by rotation about two axes so that the collector plane is always normal to the solar 
position.  The collector may a flat-plate or a concentrator using air or liquid. 

 
2.5.6  Data 
 

 
 

Select Data Location is used to first select a file of weather data and then to select the city from 
the file.  When searching for a particular city, select a city and then press the first letter in the 
name of the desired city.  There is a check box to the calculations for all cities in a file rather 
than one at a time.  When “all cities” is selected, a dialog box appears asking for the name of 
a file where data will be sent.  Information in this file can be later manipulated.   

 
Weather data for the 16 California climate zones have been supplied by the California 
Energy Commission.  The data for those cities that are in both the original F-Chart database 
and the CEC database are not the same.  The F-Chart database, USA_Old, comes from a 
1978 DOE report, Input Data for Solar Systems by V. Cinquemani, J.R. Owenby, Jr. and 
R.G. Baldwin (prepared under interagency agreement no E(49-26)-1041).  The F-Chart 
database USA_New comes from the National Solar Radiation DataBase (NSRDB) created by 
the National Renewable Energy Laboratory (NREL). 
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Change/View data is used to examine or modify any of the meteorological data for the currently 

selected city indicated in the menu title.  A dialog box will appear showing monthly values of 
the solar radiation, ambient temperature and ground reflectance. Click the cancel button if 
you are just viewing the data.  Any of these values can be changed.  Click the OK button 
after making the desired changes.  These changes will be stored along with other specific 
system information when the Save or Save as command is used.  It is also possible to 
permanently store the data, independent of the system description, by clicking the Archive 
button.   The Archive process permanently alters the master data file, so be sure that you 
have a backup copy. 
 

Add New Data allows the user to enter meteorological data for a new location.  A dialog box will 
appear with rectangular boxes in which the city name, latitude, and monthly-average values 
of the solar radiation, ambient temperature and ground reflectance.  Click the Ok button to 
save the data.  The city name will not be placed on a map, but will appear in the list of cities 
shown with the Cites Not on Map command.  This command will permanently alter the 
master data file.  It is not possible to delete a city.  Be sure that you have a backup copy of 
the original program. 

 
Create new Data File allows the user to select data from individual cities in any of the city files 

and construct a new city file. 
 

2.5.7  Run/Plot 
 

 
 

Calculate initiates the calculations for the system described by the parameter values in the 
system and economics windows.  A dialog box will appear showing the progress of the 
calculations.  The Run command generates a performance output window and, if the 
economics parameter window is open, an economics output window.  Click the mouse button 
on the window you wish to view to bring it to the front.  These output windows can be output 
to a printer, a disk file using the Print command. 
 

Parametric Plot produces a plot of solar fraction and/or live-cycle savings versus any of the 
parameters that can have continuous values.  Place the cursor on a parameter in the system, 
collector or economics parameters.  If the Parametric Plot command is available for the 
selected parameter then executing this command will bring up a dialog window where the 
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range of the parameter is selected along with the number of calculations to make within that 
range.  A spline interpolation is done between points if the box in front of Spline fit is 
checked.  The plot may be copied to the Clipboard using the Copy Window command in the 
Edit menu. 

 
Double-clicking on any plot provides a means to change the character of the plot.  Any of the 
plotting attributes can be changed but pleasing plots will be obtained with the plot default 
settings.  The number of divisions, axis font size, plotted range, the presence or absence of 
grid lines and linear or logarithmic scales can be selected and changed.   

 
Monthly Plot plots monthly values of the calculated thermal performance parameters such as 

solar fraction, incident solar energy and others as well as weather data.  These plots can only 
be generated after the calculate command has been issued.  When the Monthly Plot command 
is issued a dialog box appears.  First select either the Calculated performance or Weather data 
radio button and then select the quantity to be plotted.  The minimum and maximum values 
of the selected quantity will be displayed in the display format currently selected.   
 

2.5.8  Window 
 

 
 
System Parameters or any of the other windows can be moved to the front by selecting it.  
 
Tile and Cascade organizes the open windows on the screen.  The Tile command will place all 

windows side by side in two columns.  The Cascade command places the window currently 
being edited in front and all other windows are positioned so that only their title bars are 
showing.  These commands only affect the visual display.  
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2.5.9  Help 
 

 
 
Help Index will activate the help processor that provides specific information on the use to F-

Chart.  Help for any parameter is available by selecting the parameter and then either 
selecting Help Index or by pressing the F1 key.  Help on commands is obtained by dragging 
the cursor to the command of interest and pressing F1 or by selecting the command after 
issuing the Help Index command. 

 
Using Help provides instructions on how to move around in the help processor. 
 
F-Chart Manual starts Adobe Acrobat and displays an electronic version of this manual. 
 
About F-Chart displays the window that comes up when the F-Chart program is started.  This 

window lists the program version number and the registered owner.  This information must 
be supplied when making inquiries about the program. 

 
f-Chart Web Site opens the default browser program and sets the URL to the f-Chart web site.  

The program developers can be contacted by e-mail through the web site. 
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C H A P T E R  3  
 _____________________________________________________________________________________________ 

Collector Parameter Sets _____________________________________________________________________________________________  
 

 
Five types of solar collectors may be evaluated by F-Chart for use with any of the active solar 
systems.  The collector type is chosen from the collector menu.  The basic equation relating the 
useful energy gain of the collector to meteorological variables has the same form for all five 
collector types, as shown in Duffie and Beckman [1991].  In each case, the performance of the 
collector is described in terms of FR*TAU*ALPHA (FR(τα)) and FR*UL (FRUL).  
FR*TAU*ALPHA (also call the optical efficiency) is the efficiency the solar collector would 
have if the collector inlet temperature were equal to the ambient temperature.  FR*UL accounts 
for thermal losses.  These parameters can be determined theoretically (Duffie and Beckman 
[1991]) or experimentally from the ASHRAE 93-77 collector test procedure [1977].  Provision is 
made in the parameter set for each collector type to modify the test values of the collector 
parameters to account for incidence angle effects and changes in the collector fluid flow rate 
from the test value. 
 
In the following sections of this chapter, the parameter sets for each of the five solar collector 
types are displayed, along with their default settings in English units.  A short description of each 
parameter is provided. 
 
 
3.1  Flat-Plate Solar Collector 
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Number of collector panels is multiplied by the area of a single collector panel to determine the 
total array area. 

 
Collector panel area is either the gross or net aperture area of each collector panel.  The same 

(gross or net) aperture area that was used to determine FR*TAU*ALPHA and FR*UL must 
be used for this parameter.  The ASHRAE Standard 93-77 [1977] collector test recommends 
the use of gross area. 

 
FR*UL (Test Slope) is the product of the collector heat removal factor, FR, and the collector 

overall heat loss factor, UL.  FR*UL is the negative of the slope of the straight-line 
efficiency plot obtained from the ASHRAE Standard 93-77 [1977] collector test. 

 
FR*TAU*ALPHA (Test Intercept) is the product of the collector heat removal factor, FR, and 

the transmittance-absorptance product, TAU*ALPHA, at normal incidence.  This parameter 
is also known as the optical efficiency.  It is the Y-intercept of the straight-line efficiency 
plot obtained from the ASHRAE Standard 93-77 [1977] collector test. 

 
Collector slope is the angle between the plane of the collector aperture and the horizontal.  This 

parameter may have monthly values.  The angle is measured in a vertical plane that is 
perpendicular to the line formed by the intersection of the plane of the collector aperture and 
the horizontal plane. 

 
Collector azimuth (South=0) is the angle between the projection into the horizontal plane of the 

normal to the collector aperture and the local meridian with the zero point directly facing the 
equator, west positive, and east negative.  The azimuth of a horizontal collector can have any 
value.  The azimuth of a collector facing the sun at noon in the southern hemisphere (i.e. 
north facing) is 180.  This parameter may have monthly values. 

 
Incidence angle modifier calculation cycles through 'Glazings', 'Constant', and 'Value(s)' to 

indicate which of three possible methods is to be used to calculate the effect of incidence 
angle on FR*TAU*ALPHA.  One of the next three parameters will be available depending 
upon the selection; the other two will be hidden.  If 'Glazings' is selected, the Fresnel 
equations are used with nominal glass properties and the number of glazings will have to be 
selected.  If 'Constant' is selected, the ASHRAE incident angle modifier constant will be 
required.  If 'Value(s)' is selected, either a single incidence angle modifier or the incident 
angle modifier value for every 10 degrees will be required.  If Value(s) is selected, then 
select ‘Ang Dep’ to enter either a single value or a value every 10 degrees in the dialog 
window. 
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Number of glazings can be 1 to 4.  Values of the monthly-average incidence angle modifier are 

calculated using the Fresnel equations with glass properties and the method described in 
Duffie and Beckman [1991]. 

 
Inc angle modifier constant, b, is the parameter which provides the best fit in the equation K(t) 

= 1.0 - b (1/cos(t) - 1.0) where K(t) is the ratio of the transmittance-absorptance product at 
incidence angle t to the normal incidence transmittance-absorptance product.  The constant, 
b, is determined experimentally as described in the ASHRAE Standard 93-77 collector test 
procedure [1977].  This parameter is active only if 'Constant' was chosen for the incidence 
angle modifier type. 

 
Inc angle modifier value(s) are the value(s) of the collector incidence angle modifier, K(t) as 

determined by the ASHRAE Standard 93-77 collector test procedure [1977].  If a single 
value is used for this parameter, then the incidence angle modifier is taken to be that constant 
value independent of solar incidence angle.  Alternatively, values of this parameter may be 
specified for incidence angles between 0 and 90 degrees in 10-degree increments.  The 
incidence angle value(s) are used only if 'Value(s)' was chosen for the incidence angle 
modifier type. 

 
Collector flow rate/area is the total mass flow rate of collector fluid through the collector array 

divided by the total collector array area.  This flow rate may be different from the flow rate at 
which the collector was tested.  Typical values of this flow rate are 11 lb/hr-ft2 or 0.015 kg/s-
m2 for liquids and 9 lb/hr-ft2 or 0.012 kg/s-m2 for air. 

 
Collector fluid specific heat is the specific heat of the fluid flowing through the collectors.  

Properties can be found in the ASHRAE handbook of Fundamentals [1985] or in any heat 
transfer textbook.  For water, use 1.0 Btu/lb-F or 4.19 kJ/kg-K.  For air use 1.0 kJ/kg-K or 
0.24 Btu/lb-F. 

 
Modify Test Values (Yes/No) toggles to indicate if the next two parameters should be used to 

account for differences in the collector parameters due to differences in the actual and test 
fluid flow rates and series-parallel fluid flow circuit arrangements.  If this parameter is set to 
No, the following two parameters are ignored. 

 
Test collector flow rate/area is the ratio of the collector fluid flow rate used in the collector test 

to the array area of the collector tested.  Usually, a single collector panel is tested.  In this 
case, this parameter is the ratio of the test collector fluid flow rate to the collector panel area.  
This parameter is used only if Yes has been selected for 'modify test values'. 

 
Test fluid specific heat is the specific heat of the fluid used in the collector test. Properties of 

common materials can be found in the ASHRAE Handbook of Fundamentals [1985] or in 
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any heat transfer textbook.  This parameter is used if Yes is selected for 'modify test values'. 

 
 
3.2  Evacuated Tube Collectors 

 

 
 

Number of collector panels is multiplied by the area of a single collector panel to determine the 
total array area. 

 
Collector panel area is either the gross or net aperture area of each collector panel.  The same 

(gross or net) aperture area that was used to determine FR*TAU*ALPHA and FR*UL must 
be used for this parameter.  The ASHRAE Standard 93-77 [1977] collector test recommends 
the use of gross area. 

 
FR*UL (Test Slope) is the product of the collector heat removal factor, FR, and the collector 

overall heat loss factor, UL.  FR*UL is the negative of the slope of the straight line efficiency 
plot obtained from the ASHRAE Standard 93-77 [1977] collector test. 

 
FR*TAU*ALPHA (Test Intercept) is the product of the collector heat removal factor, FR, and 

the transmittance-absorptance product, TAU*ALPHA, at normal incidence.  This parameter 
is also known as the optical efficiency.  It is the Y-intercept of the straight line efficiency plot 
obtained from the ASHRAE Standard 93-77 [1977] collector test. 

 
Collector slope is the angle between the plane of the collector aperture and the horizontal.  This 

parameter may have monthly values.  The angle is measured in a vertical plane that is 
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perpendicular to the line formed by the intersection of the plane of the collector aperture and 
the horizontal plane. 

 
Collector azimuth (South=0) is the angle between the projection into the horizontal plane of the 

normal to the collector aperture and the local meridian with the zero point directly facing the 
equator, west positive, and east negative.  The azimuth of a horizontal collector can have any 
value.  The azimuth of a collector facing the sun at noon in the southern hemisphere (i.e. 
north facing) is 180¡ .  This parameter may have monthly values. 

 
Receiver orientation (EW,NS) toggles to indicate the axis orientation of the evacuated tubes.  

Specify NS if the collectors are mounted vertically with the tube pointing up and down. 
 
Incidence angle modifier (Perpendicular) values(s) are the incidence angle modifiers for the 

plane perpendicular to the tube axis (i.e., the transverse plane).  The incidence angle modifier 
is the ratio of the transmittance-absorptance product at an off-normal incidence angle in the 
transverse plane to the normal incidence transmittance-absorptance product.  This parameter 
may have either one or ten values.  A single value indicates that the incidence angle modifier 
is independent of solar incidence angle.  The ten values, as shown above for the default 
parameter set, correspond to the incidence angle modifier values between 0 and 90 degrees in 
10-degree increments. 

 
Incidence angle modifier (Parallel) value(s) are the incidence angle modifiers for the plane 

parallel to the tube axis (i.e., the longitudinal plane).  The incidence angle modifier is the 
ratio of the transmittance-absorptance product at an off-normal incidence angle in the 
longitudinal plane to the normal incidence transmittance-absorptance product.  This 
parameter may have either one or ten values.  A single value indicates that the incidence 
angle modifier is independent of solar incidence angle.  The ten values, as shown above for 
the default parameter set, correspond to the incidence angle modifier values between 0 and 
90 degrees in 10-degree increments. 

 
Collector flow rate/area is the total mass flow rate of collector fluid through the collector array 

divided by the total collector array area.  This flow rate may be different from the flow rate at 
which the collector was tested.  Typical values of this flow rate are 11 lb/hr-ft2 or 0.015 kg/s-
m2 for liquids and 9 lb/hr-ft2 or 0.012 kg/s-m2 for air. 

 
Collector fluid specific heat is the specific heat of the fluid flowing through the collectors.  

Properties can be found in the ASHRAE handbook of Fundamentals [1985] or in any heat 
transfer textbook.  For water, use 1.0 Btu/lb-F or 4.19 kJ/kg-K.  For air use 1.0 kJ/kg-K or 
0.24 Btu/lb-F. 

 
Modify Test Values (Yes/No) toggles to indicate if the next two parameters should be used to 
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account for differences in the collector parameters due to differences in the actual and test 
fluid flow rates and series-parallel fluid flow circuit arrangements.  If this parameter is set to 
No, the following three parameters are ignored. 

 
Test collector flow rate/area is the ratio of the collector fluid flow rate used in the collector test 

to the array area of the collector tested.  Usually, a single collector panel is tested.  In this 
case, this parameter is the ratio of the test collector fluid flow rate to the collector panel area.  
This parameter is used only if Yes has been selected for 'modify test values'. 

 
Test fluid specific heat is the specific heat of the fluid used in the collector test. Properties of 

common materials can be found in the ASHRAE Handbook of Fundamentals [1985] or in 
any heat transfer textbook.  This parameter is used only if Yes is selected for 'modify test 
values'. 

 
 

3.3  Compound Parabolic Concentrating Collector 
 

 
 

Number of collector panels is multiplied by the area of a single collector panel to determine the 
total array area. 

 
Collector panel area is either the gross or net aperture area of each collector panel.  The same 

(gross or net) aperture area that was used to determine FR*TAU*ALPHA and FR*UL must 
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be used for this parameter.  The ASHRAE Standard 93-77 [1977] collector test recommends 
the use of gross area. 

 
FR*UL (Test Slope) is the product of the collector heat removal factor, FR, and the collector 

overall heat loss factor, UL.  FR*UL is the negative of the slope of the straight-line 
efficiency plot obtained from the ASHRAE Standard 93-77 [1977] collector test. 

 
FR*TAU*ALPHA (Test Intercept) is the product of the collector heat removal factor, FR, and 

the transmittance-absorptance product, TAU*ALPHA, at normal incidence.  This parameter, 
also known as the optical efficiency, is the Y-intercept of the straight-line efficiency plot 
obtained from the ASHRAE Standard 93-77 [1977] collector test. 

 
Concentration ratio is the ratio of the collector aperture area to the receiver area. 
 
Acceptance half-angle is the maximum angle measured from the axis of the CPC for which 

incident beam solar radiation will strike the absorber. 
 
Collector slope is the angle between the plane of the collector aperture and the horizontal.  This 

parameter may have monthly values.  The angle is measured in a vertical plane that is 
perpendicular to the line formed by the intersection of the plane of the collector aperture and 
the horizontal plane. 

 
Collector azimuth (South=0) is the angle between the projection into the horizontal plane of the 

normal to the collector aperture and the local meridian with the zero point directly facing the 
equator, west positive, and east negative.  The azimuth of a horizontal collector can have any 
value.  The azimuth of a collector facing the sun at noon in the southern hemisphere (i.e. 
north facing) is 180°.  This parameter may have monthly values. 

 
Receiver orientation (EW, NS) toggles to indicate the axis orientation of the evacuated tubes.  

Specify NS if the collectors are mounted vertically with the tube pointing up and down. 
 
Incidence angle modifier (Perpendicular) values(s) are the incidence angle modifiers for the 

plane perpendicular to the tube axis (i.e., the transverse plane).  The incidence angle modifier 
is the ratio of the transmittance-absorptance product at an off-normal incidence angle in the 
transverse plane to the normal incidence transmittance-absorptance product.  This parameter 
may have either one or ten values.  A single value indicates that the incidence angle modifier 
is independent of solar incidence angle.  The ten values, as shown above for the default 
parameter set, correspond to the incidence angle modifier values between 0 and 90 degrees in 
10 degree increments. 

 
Incidence angle modifier (Parallel) value(s) are the incidence angle modifiers for the plane 
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parallel to the tube axis (i.e., the longitudinal plane).  The incidence angle modifier is the 
ratio of the transmittance-absorptance product at an off-normal incidence angle in the 
longitudinal plane to the normal incidence transmittance-absorptance product.  This 
parameter may have either one or ten values.  A single value indicates that the incidence 
angle modifier is independent of solar incidence angle.  The ten values, as shown above for 
the default parameter set, correspond to the incidence angle modifier values between 0 and 
90 degrees in 10 degree increments. 

 
Collector flow rate/area is the total mass flow rate of collector fluid through the collector array 

divided by the total collector array area.  This flow rate may be different from the flow rate at 
which the collector was tested.  Typical values of this flow rate are 11 lb/hr-ft2 or 0.015 kg/s-
m2 for liquids and 9 lb/hr-ft2 or 0.012 kg/s-m2 for air. 

 
Collector fluid specific heat is the specific heat of the fluid flowing through the collectors.  

Properties can be found in the ASHRAE handbook of Fundamentals [1985] or in any heat 
transfer textbook.  For water, use 1.0 Btu/lb-F or 4.19 kJ/kg-K.  For air use 1.0 kJ/kg-K or 
0.24 Btu/lb-F. 

 
Modify Test Values (Yes/No) toggles to indicate if the next two parameters should be used to 

account for differences in the collector parameters due to differences in the actual and test 
fluid flow rates and series-parallel fluid flow circuit arrangements.  If this parameter is set to 
No, the following three parameters are ignored. 

 
Test collector flow rate/area is the ratio of the collector fluid flow rate used in the collector test 

to the array area of the collector tested.  Usually, a single collector panel is tested.  In this 
case, this parameter is the ratio of the test collector fluid flow rate to the collector panel area.  
This parameter is used only if Yes has been selected for 'modify test values'. 

 
Test fluid specific heat is the specific heat of the fluid used in the collector test. Properties of 

common materials can be found in the ASHRAE Handbook of Fundamentals [1985] or in 
any heat transfer textbook.  This parameter is used only if Yes is selected for 'modify test 
values'. 
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3.4  One-Axis Tracking Collector 

 

 
 
Number of collector panels is multiplied by the area of a single collector panel to determine the 

total array area. 
 
Collector panel area is either the gross or net aperture area of each collector panel.  The same 

(gross or net) aperture area that was used to determine FR*TAU*ALPHA and FR*UL must 
be used for this parameter.  The ASHRAE Standard 93-77 [1977] collector test recommends 
the use of gross area. 

 
FR*UL (Test Slope) is the product of the collector heat removal factor, FR, and the collector 

overall heat loss factor, UL.  FR*UL is the negative of the slope of the straight line efficiency 
plot obtained from the ASHRAE Standard 93-77 [1977] collector test. 

 
FR*TAU*ALPHA (Test Intercept) is the product of the collector heat removal factor, FR, and 

the transmittance-absorptance product, TAU*ALPHA, at normal incidence.  This parameter, 
also known as the optical efficiency, is the Y-intercept of the straight line efficiency plot 
obtained from the ASHRAE Standard 93-77 [1977] collector test. 

 
Concentration ratio is the ratio of the collector aperture area to the receiver area. 
 
Axis slope is the angle between the axis and the projection of the axis into the horizontal plane.  

This parameter may have monthly values. 
 
Axis azimuth (South = 0) is the angle between the projection of the axis into the horizontal 
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plane and the local meridian.  An east-west axis orientation will have an axis azimuth of 90°.  

 
Incidence angle modifier are the value(s) of the collector incidence angle modifier, K(t) as 

determined by the ASHRAE Standard 93-77 collector test procedure [1977].  If a single 
value is used for this parameter, then the incidence angle modifier is taken to be that constant 
value independent of solar incidence angle.  Alternatively, values of this parameter may be 
specified for incidence angles between 0 and 90 degrees in 10-degree increments.  The 
incidence angle value(s) are used only if 'Value(s)' was chosen for the incidence angle 
modifier type. 

 
Collector flow rate/area is the total mass flow rate of collector fluid through the collector array 

divided by the total collector array area.  This flow rate may be different from the flow rate at 
which the collector was tested.  Typical values of this flow rate are 11 lb/hr-ft2 or 0.015 kg/s-
m2 for liquids and 9 lb/hr-ft2 or 0.012 kg/s-m2 for air. 

 
Collector fluid specific heat is the specific heat of the fluid flowing through the collectors.  

Properties can be found in the ASHRAE handbook of Fundamentals [1985] or in any heat 
transfer textbook.  For water, use 1.0 Btu/lb-F or 4.19 kJ/kg-K.  For air use 1.0 kJ/kg-K or 
0.24 Btu/lb-F. 

 
Modify Test Values (Yes/No) toggles to indicate if the next two parameters should be used to 

account for differences in the collector parameters due to differences in the actual and test 
fluid flow rates and series-parallel fluid flow circuit arrangements.  If this parameter is set to 
No, the following three parameters are ignored. 

 
Test collector flow rate/area is the ratio of the collector fluid flow rate used in the collector test 

to the array area of the collector tested.  Usually, a single collector panel is tested.  In this 
case, this parameter is the ratio of the test collector fluid flow rate to the collector panel area.  
This parameter is used only if Yes has been selected for 'modify test values'. 

 
Test fluid specific heat is the specific heat of the fluid used in the collector test. Properties of 

common materials can be found in the ASHRAE Handbook of Fundamentals [1985] or in 
any heat transfer textbook.  This parameter is used only if Yes is selected for 'modify test 
values'. 
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3.5  Two-Axis Tracking Collector 
 

 
 
Number of collector panels is multiplied by the area of a single collector panel to determine the 

total array area. 
 
Collector panel area is either the gross or net aperture area of each collector panel.  The same 

(gross or net) aperture area that was used to determine FR*TAU*ALPHA and FR*UL must 
be used for this parameter.  The ASHRAE Standard 93-77 [1977] collector test recommends 
the use of gross area. 

 
FR*UL (Test Slope) is the product of the collector heat removal factor, FR, and the collector 

overall heat loss factor, UL.  FR*UL is the negative of the slope of the straight line efficiency 
plot obtained from the ASHRAE Standard 93-77 [1977] collector test. 

 
FR*TAU*ALPHA (Test Intercept) is the product of the collector heat removal factor, FR, and 

the transmittance-absorptance product, TAU*ALPHA, at normal incidence.  This parameter 
is also known as the optical efficiency.  It is the Y-intercept of the straight line efficiency plot 
obtained from the ASHRAE Standard 93-77 [1977] collector test. 

 
Concentration ratio is the ratio of the collector aperture area to the receiver area. 
 
Collector flow rate/area is the total mass flow rate of collector fluid through the collector array 

divided by the total collector array area.  This flow rate may be different from the flow rate at 
which the collector was tested.  Typical values of this flow rate are 11 lb/hr-ft2 or 0.015 kg/s-
m2 for liquids and 9 lb/hr-ft2 or 0.012 kg/s-m2 for air. 

 
Collector fluid specific heat is the specific heat of the fluid flowing through the collectors.  
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Properties can be found in the ASHRAE handbook of Fundamentals [1985] or in any heat 
transfer textbook.  For water, use 1.0 Btu/lb-F or 4.19 kJ/kg-K.  For air use 1.0 kJ/kg-K or 
0.24 Btu/lb-F. 

 
Modify Test Values (Yes/No) toggles to indicate if the next two parameters should be used to 

account for differences in the collector parameters due to differences in the actual and test 
fluid flow rates and series-parallel fluid flow circuit arrangements.  If this parameter is set to 
No, the following three parameters are ignored. 

 
Test collector flow rate/area is the ratio of the collector fluid flow rate used in the collector test 

to the array area of the collector tested.  Usually, a single collector panel is tested.  In this 
case, this parameter is the ratio of the test collector fluid flow rate to the collector panel area.  
This parameter is used only if Yes has been selected for 'modify test values'. 

 
Test fluid specific heat is the specific heat of the fluid used in the collector test. Properties of 

common materials can be found in the ASHRAE Handbook of Fundamentals [1985] or in 
any heat transfer textbook.  This parameter is used only if Yes is selected for 'modify test 
values'. 
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C H A P T E R  4  
 _____________________________________________________________________________________________ 

System and Output Descriptions _____________________________________________________________________________________________  
 
 

The F-Chart program can evaluate eight different solar energy system types.  Each system has 
its own input parameter set and output format.  A description of each system is provided in the 
following eight sections, along with a description of its parameter set, an example calculation 
and an explanation of the program output. The economic parameters and output are the same for 
all systems and are described in Chapter 5. 
 
The algorithms used to calculate the thermal and economic performance of the systems can be 
found in the cited references following Chapter 5.  The monthly-average solar radiation on tilted 
surfaces is calculated for all systems from the horizontal solar radiation data by summing the 
long-term average hourly values calculated using the isotropic sky model in the manner 
described in Section 2.15 of Duffie and Beckman [1991].  The monthly diffuse fraction is 
estimated using the correlation developed by Erbs et al. [1982].   
 
 
4.1  Active Domestic Hot Water System  
 
A common configuration of a solar domestic water heating system is the two-tank system shown 
in Figure 4.1.  The collector may heat either air or liquid.  The collected energy is transferred 
directly or via a heat exchanger to a domestic water preheat tank which supplies solar-heated 
water to a conventional auxiliary water heater.  The water is further heated to the desired 
temperature by the conventional water heater.  The f-Chart method for domestic water heating 
was originally developed for two-tank systems.  However, it is shown by Buckles et al. [1980] 
that the f-Chart method can also be used for single-tank systems in which auxiliary energy is 
supplied to the upper portion of the solar preheat tank. 
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Figure 4.1:  Two-Tank Domestic Water Heating System  
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The parameters for the active domestic hot water system are listed below along with their default 
values in English units.  A description of each parameter follows the parameter listing. 

 

 
 
Location is the location where the system is located.  Existing city data can be viewed or 

changed or data for a new city added from the Data pull down menu. 
 
Water storage volume / collector area is multiplied by the number of collector panels and the 

panel area to determine the volume of stored water used for thermal storage.  In a single tank 
system, use the volume below the heating element thermostat.  

 
Fuel cycles through the four possibilities of the back-up fuel (Elecricity, Gas, Oil, Other) where 

'Other' represents, for example, wood.  This parameter is used only in the economic 
evaluation. 

 
Efficiency of fuel usage represents the average furnace efficiency of the back-up (conventional) 

fuel.  This parameter is used in the economics calculations and it may vary monthly. 
 
Daily hot water usage is the average amount of hot water per day required at the set 

temperature.  Monthly values are allowed.   
 
Water set temperature is the temperature to which domestic water is to be heated.  Monthly 

values are allowed.   
 
Environment temperature is the temperature of the surroundings of the domestic water storage 
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tank to which heat losses occur.  Monthly values are allowed.   

 
UA of auxiliary storage tank is the product of the energy loss coefficient and surface area for 

the auxiliary tank in the solar domestic water heating system.  In a single tank system, use the 
tank surface area above the heating element thermostat.   

 
Pipe heat loss toggles between Yes and No to indicate if the following two parameters are to be 

used to calculate the effect of pipe heat losses.  If No is selected, the following two 
parameters are ignored. 

 
Inlet pipe UA is the overall loss coefficient-pipe area product for the pipe carrying fluid to the 

collector.  This parameter is used only if Yes has been selected for pipe heat loss. 
 
Outlet pipe UA is the overall loss coefficient-pipe area product for the pipe carrying fluid from 

the collector array.  This parameter is used only if Yes has been selected for pipe heat loss. 
 
Collector-store heat exchanger toggles between Yes and No to indicate if the following two 

parameters should be used to account for the performance penalty resulting from the heat 
exchanger between the collector array and the storage tank.  If No is specified, the following 
two parameters are ignored. 

 
Tank side flow rate/area is the mass flow rate of water from the storage tank through the 

collector-storage heat exchanger divided by the total array area.  Set this parameter to a value 
that is larger than collector flow rate/area (in the collector parameter set) for an internal heat 
exchanger. 

 
Heat exchanger effectiveness is the ratio of the actual to maximum possible heat transfer rates 

for heat exchanger located between the collector and the storage unit.  This parameter is used 
only if Yes is selected for the collector-storage heat exchanger. 

 
The thermal performance is calculated on a monthly basis.  Shown below is the output for the 
default parameter set in English units with three flat-plate solar panels in Miami FL. 
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Heat is the monthly total space heating demand. 
 
Dhw is the monthly total water heating demand. 
 
Aux is the monthly total auxiliary energy required to supply the space and domestic water 

heating demands. 
 
f is the fraction of the space and domestic water heating demands which is supplied by the solar 
energy system.  The remaining fraction must be met by an auxiliary source. 
 
 
4.2  Pebble Bed Storage Space and Domestic Water Heating Systems 
 
A common configuration of a solar heating system using a pebble bed for thermal is shown in 
Figure 4.2.  Other arrangements of fans and dampers can be devised to result in an equivalent 
flow circuit.  Air is heated in the flat-plate solar collector and circulated to either the house or to 
the pebble bed.  Energy is stored in the pebble bed by heating the pebbles with the circulating hot 
air.  At night, or in cloudy weather when the available solar energy is insufficient to meet the 
heating load directly, air is warmed as it is circulated through the pebble bed and is then 
delivered to the house.  Auxiliary energy is supplied from the furnace when the energy stored in 
the pebble bed is depleted.  Energy required for domestic hot water is provided in some systems 
by heat exchange with the hot air leaving the collector. 
 
The thermal performance of the pebble bed storage system is estimated using the f-Chart method 
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as described by Beckman, Klein and Duffie [1977] and in Duffie and Beckman [1991].  Note 
that the thermal performance of a domestic water heating system alone (without space heating) 
should be evaluated using the active domestic hot water system described above, even if air 
heaters are used.   
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Figure 4.2:  Pebble Bed Storage Space and Water Heating System 
 

 
The parameters for the pebble bed storage system are listed below along with their default values 
in English units.  A description of each parameter follows the parameter listing. 
 

 
 

 
39 
 



 
Chapter 4 

 
Location is the location where the system is located.  Existing city data can be viewed or 

changed or data for a new city added from the Data pull down menu. 
 

Volume of pebble bed / collector area is multiplied by the number of collector panels and the 
panel area to determine the total volume occupied by the pebbles including voids. 
 

Building UA is the building overall energy loss coefficient-area product. See Chapter 25 of the 
ASHRAE Handbook of Fundamentals [1985] for additional information.  This parameter 
may have monthly values.  If the monthly loads are known, either from measurements or 
independent calculations, you may change the value of UA monthly so the program 
calculates the known monthly load.  F-Chart will multiply the UA and the degree-days and 
either the number of hours in a day (English units) or seconds in a day (SI units) to determine 
the load.  Consequently, the monthly value of UA must be calculated as [Monthly Load in 
BTUs] /[Degree-days in F-days]/24 for English units or as [Monthly Load in 
Joules]/[Degree-days in C-days]/ [24*3600] for SI units. 
 

Fuel cycles through the four possibilities of the back-up fuel (Electricity, Gas, Oil, Other) where 
'Other' represents, for example, wood.  This parameter is used only in the economic 
evaluation of the system. 
 

Efficiency of fuel usage represents the average furnace efficiency of the back-up (conventional) 
fuel.  This parameter is used in the economics calculations and it may vary monthly. 
 

Domestic hot water toggles between Yes and No to indicate whether a solar domestic water 
heating system is part of the heating system.  If Yes is selected, a solar domestic hot water 
system is considered in addition to the space heating system.  The following 6 parameters are 
then used to describe the domestic water system.  If No is specified, the following 6 
parameters are ignored.  The liquid storage system should be selected if air collectors and a 
water-to-air heat exchanger are used to supply only domestic hot water. 
 

Daily hot water usage is the average amount of hot water per day required at the set 
temperature.  Monthly values are allowed.  This parameter is visible only if Yes has been 
selected for domestic hot water parameter. 
 

Water set temperature is the temperature to which domestic water is to be heated.  Monthly 
values are allowed.  This parameter is used only if Yes has been selected for domestic hot 
water. 

Environment temperature is the temperature of the surroundings of the domestic water storage 
tank to which heat losses occur.  Monthly values are allowed.  This parameter is used only if 
Yes has been selected for domestic hot water. 
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UA of auxiliary storage tank is the product of the energy loss coefficient and surface area for 

the auxiliary tank in the solar domestic water heating system.  In a single tank system, use the 
tank surface area above the heating element thermostat.  This parameter is visible only if Yes 
has been selected for domestic hot water. 
 

Heat exchanger water flow rate is the mass flow rate of water from the solar preheat tank to the 
air-water heat exchanger.  This parameter is visible only if Yes has been selected for 
domestic hot water.  
 

Air-water heat exch effectiveness is the ratio of the actual heat transfer rate to the maximum 
possible heat transfer rate for the air-to-water domestic hot water heat exchanger.  This 
parameter is used only if Yes has been selected for domestic hot water. 
 

Duct losses (Yes/No) toggles to indicate whether the following four parameters are to be used to 
calculate the effect of duct heat losses and air leaks.  If No is specified, the following four 
parameters are ignored. 
 

Inlet duct UA is the overall loss coefficient-duct area product for the duct carrying air to the 
collector array.  This parameter is used only if Yes has been selected for duct losses. 
 

Outlet duct UA is the overall loss coefficient-duct area product for the duct carrying air from the 
collector array.  This parameter is used only if Yes has been selected for duct losses. 
 

Percent duct leak rate is the percent of the collector outlet duct flow rate which is leakage.  The 
collector is assumed to be under negative pressure, i.e., all leaks are into the ducts rather than 
out.  This parameter is used only if Yes has been selected for duct losses. 

 
Leak location (In, Out, Both) cycles through 'In', 'Out', and 'Both' to indicate the location of the 

duct air leakage.  The total air leakage into the ducts as specified by the percent duct leak rate 
may be assumed to occur from the inlet duct, the outlet duct, or evenly from both the inlet 
and outlet ducts.  This parameter is used only if Yes has been selected for duct losses. 
 
The thermal performance is calculated on a monthly basis.  The output (in English units) for 
the default parameter with a flat-plate collector appears below. (26 panels and cp=0.24) 
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Solar is the monthly total solar radiation incident on the collector surface. 
 
Heat is the monthly total space heating demand. 
 
Dhw is the monthly total water heating demand. 
 
Aux is the monthly total auxiliary energy required to supply the space and domestic water 

heating demands. 
 
f is the fraction of the space and domestic water heating demands which is supplied by the solar 

energy system.  The remaining fraction must be met by an auxiliary source. 
 
 
4.3  Water Storage Space and/or Domestic Water Heating Systems 
 
The water storage solar heating systems considered here can supply space heat, domestic hot 
water, or both.  A schematic diagram of a typical combined space and domestic water heating 
system is shown in Figure 4.3.  This system uses an antifreeze solution as the heat transfer fluid 
in the collector loop.  (Alternatively, water may be circulated directly through the collectors and 
drained at night or during periods of excessive cloudiness.)  Energy is stored in the form of 
sensible heat in the water tank.  A water-to-air load heat exchanger is used to transfer heat from 
the storage tank to the building.  A liquid-to-liquid heat exchanger is used to transfer energy 
from the main storage tank to the domestic water preheat tank, which in turn, supplies solar 
heated water to a conventional water heater.  (A single-tank arrangement in which auxiliary heat 
is supplied to the upper portion of the solar preheat tank can also be evaluated.)  A conventional 
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heating unit (e.g., a furnace, heat pump, or wood burner) is used to meet the space-heating load 
when the energy in the storage tank is depleted. The f-Chart method [Beckman, Klein and Duffie 
(1977)] is used to evaluate the monthly system performance. 
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Figure 4.3:  Water Storage Space and Water Heating System  
 
The water storage system input parameters and their default values appear below in English units 
followed by the parameter descriptions.  
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Location is the location where the system is located.  Existing city data can be viewed or 

changed or data for a new city added from the Data pull down menu. 
 
Water storage volume / collector area is multiplied by the number of collector panels and the 

panel area to determine the volume of stored water used for thermal storage.  If the building 
UA is set to zero, then calculations are done for solar domestic water heating only.  In this 
case, this parameter should be the volume of the domestic water preheat tank divided by the 
total collector area.  In a single tank system, use the volume below the heating element 
thermostat.  

 
Building UA is the building overall energy loss coefficient-area product. See Chapter 25 of the 

ASHRAE Handbook of Fundamentals [1985] for additional information.  If only domestic 
hot water is to be considered, this parameter should be set to zero.  This parameter may have 
monthly values.  If the monthly loads are known, either from measurements or independent 
calculations, you may change the value of UA monthly so the program calculates the the 
known monthly load.  F-Chart will multiply the UA and the degree-days and either the 
number of hours in a day (English units) or seconds in a day (SI units) to determine the load.  
Consequently, the monthly value of UA must be calculated as [Monthly Load in BTUs] 
/[Degree-days in F-days]/24 for English units or as [Monthly Load in Joules]/[Degree-days in 
C-days]/ [24*3600] for SI units. 

 
Fuel cycles through the four possibilities (Electricity, Gas, Oil, Other) of the back-up fuel where 

'Other' represents, for example, wood.  This parameter is used only in the economic 
evaluation. 

 
Efficiency of fuel usage represents the average furnace efficiency of the back-up (conventional) 

fuel.  This parameter is used in the economics calculations and it may vary monthly. 
 
Domestic hot water (Yes/No) toggles to indicate whether a solar domestic water heating system 

is part of the heating system.  If Yes is selected, a solar domestic hot water system is 
considered in addition to the space heating system.  The following 6 parameters are then used 
to describe the domestic water system.  If No is specified, the following 6 parameters are 
ignored.  The liquid storage system should be selected if air collectors and a water-to-air heat 
exchanger are used to supply only domestic hot water. 

 
Daily hot water usage is the average amount of hot water per day required at the set 

temperature.  Monthly values are allowed.  This parameter is visible only if Yes has been 
selected for domestic hot water parameter. 

 
Water set temperature is the temperature to which domestic water is to be heated.  Monthly 

values are allowed.  This parameter is used only if Yes has been selected for domestic hot 
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water. 

 
Environment temperature is the temperature of the surroundings of the domestic water storage 

tank to which heat losses occur.  Monthly values are allowed.  This parameter is used only if 
Yes has been selected for domestic hot water. 

 
UA of auxiliary storage tank is the product of the energy loss coefficient and surface area for 

the auxiliary tank in the solar domestic water heating system.  In a single tank system, use the 
tank surface area above the heating element thermostat.  This parameter is visible only if Yes 
has been selected for domestic hot water. 

 
Pipe heat loss (Yes, No) toggles to indicate if the following two parameters are to be used to 

calculate the effect of pipe heat losses.  If No is selected, the following two parameters are 
ignored. 

 
Inlet pipe UA is the overall loss coefficient-pipe area product for the pipe carrying fluid to the 

collector.  This parameter is used only if Yes has been selected for pipe heat loss. 
 
Outlet pipe UA is the overall loss coefficient-pipe area product for the pipe carrying fluid from 

the collector array.  This parameter is used only if Yes has been selected for pipe heat loss. 
 
Relative load heat exchanger size is the ratio of the actual thermal size of the load heat 

exchanger to the standard value.  The standard value is chosen such that the product of the 
load heat exchanger effectiveness and minimum capacitance rate (i.e., mass flow rate times 
specific heat) is equal to twice the value of the building UA.  This parameter may have 
monthly values. 

 
Collector-store heat exchanger (Yes, No) toggles to indicate if the following two parameters 

should be used to account for the performance penalty resulting from the heat exchanger 
between the collector array and the storage tank.  If No is specified, the following two 
parameters are ignored. 

 
Tank side flow rate/area is the mass flow rate of water from the storage tank through the 

collector-storage heat exchanger divided by the total array area.  Set this parameter to a value 
which is larger than collector flow rate/area (in the collector parameter set) for an internal 
heat exchanger. 

 
Heat exchanger effectiveness is the ratio of the actual to maximum possible heat transfer rates 

for heat exchanger located between the collector and the storage unit.  This parameter is used 
only if Yes is selected for the collector-storage heat exchanger. 
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The thermal performance is calculated on a monthly basis.  Shown below is the output for the 
default parameter set in English units with 26 flat-plate solar collectors and collector fluid 
specific heat equal to 0.8. 
 

 
 

Solar is the monthly total solar radiation incident on the collector surface. 
 
Heat is the monthly total space heating demand. 
 
Dhw is the monthly total water heating demand. 
 
Aux is the monthly total auxiliary energy required to supply the space and domestic water 

heating demands. 
 
f is the fraction of the space and domestic water heating demands which is supplied by the solar 

energy system.  The remaining fraction must be met by an auxiliary source. 
 
 
4.4  Building Storage Systems 
 
Shown in Figure 4.3 is a schematic of a simple solar space heating system which does not have a 
primary storage component.  Solar energy is used to heat a fluid (usually air, but possibly a 
liquid) which is circulated through the collectors.  The useful energy gain of the fluid is 
transferred either directly (for air) or via heat exchange (for liquids) to the building space.  If the 
solar contribution is less than the instantaneous load, all of the energy entering the space at this 
time is useful in offsetting auxiliary energy use.  If the solar gain exceeds the instantaneous load, 
the building temperature will rise, providing a means of energy storage.  If the building 
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temperature exceeds the maximum allowable value, the collector pump is turned off since the 
solar gain cannot be used or stored at this time. The algorithm used to do the monthly 
performance calculations for this system is presented by Evans and Klein [1983].  A domestic 
hot water heat exchanger can be installed in the line leading from the collector.  In this case the 
monthly DHW solar contribution is calculated by the f-Chart method [Beckman, Klein and 
Duffie (1977)]. 
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Figure 4.4:  Active Collection with Building Storage System  

 
The parameters for this system are listed below along with their default values and explanations. 
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Location is the location where the system is located.  Existing city data can be viewed or 
changed or data for a new city added from the Data pull down menu. 

 
Building UA is the building overall energy loss coefficient-area product. See Chapter 25 of the 

ASHRAE Handbook of Fundamentals [1985] for additional information.  This parameter 
may have monthly values.  If the monthly loads are known, either from measurements or 
independent calculations, you may change the value of UA monthly so the program 
calculates the the known monthly load.  F-Chart will multiply the UA and the degree-days 
and either the number of hours in a day (English units) or seconds in a day (SI units) to 
determine the load.  Consequently, the monthly value of UA must be calculated as [Monthly 
Load in BTUs] /[Degree-days in F-days]/24 for English units or as [Monthly Load in 
Joules]/[Degree-days in C-days]/ [24*3600] for SI units. 

 
Building storage capacity is the effective energy storage capacity of the building.  A value of 6 

BTU per square foot (123 KJ per square meter) of floor area is recommended for residential 
construction.  This parameter may have monthly values. 

Low thermostat set temperature is the temperature of the indoor space at which the auxiliary 
furnace turns on.   This parameter may have monthly values.  

 
Daily internal generation is the monthly-average daily energy generated within the building by 

appliances, lights, people, and solar gains other than those attributed to the solar collector 
system.  This parameter may have monthly values.   

 
Allowable temperature swing is the number of degrees above the low set point temperature 

which the indoor space may be heated to before the solar collector fluid flow is terminated.  
This parameter may have monthly values.   

 
Fuel cycles through the four possibilities of the back-up fuel (Electricity, Gas, Oil, Other) where 

'Other' represents, for example, wood.  This parameter is used only in the economic 
evaluation of the system. 

 
Efficiency of fuel usage represents the average furnace efficiency of the back-up (conventional) 

fuel.  This parameter is used in the economics calculations and it may vary monthly. 
 
Duct losses (Yes/No) toggles to indicate whether the following four parameters are to be used to 

calculate the effect of duct heat losses and air leaks.  If No is specified, the following four 
parameters are ignored. 

 
Inlet duct UA is the overall loss coefficient-duct area product for the duct carrying air to the 

collector array.  This parameter is used only if Yes has been selected for duct losses. 
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Outlet duct UA is the overall loss coefficient-duct area product for the duct carrying air from the 

collector array.  This parameter is used only if Yes has been selected for duct losses. 
 
Percent duct leak rate is the percent of the collector outlet duct flow rate which is leakage.  The 

collector is assumed to be under negative pressure, i.e., all leaks are into the ducts rather than 
out.  This parameter is used only if Yes has been selected for duct losses. 

 
Domestic hot water (Yes/No) toggles to indicate whether a solar domestic water heating system 

is part of the heating system.  If Yes is selected, a solar domestic hot water system is 
considered in addition to the space heating system.  The following 6 parameters are then used 
to describe the domestic water system.  If No is specified, the following 6 parameters are 
ignored.  The liquid storage system should be selected if air collectors and a water-to-air heat 
exchanger are used to supply only domestic hot water. 

 
Daily hot water usage is the average amount of hot water per day required at the set 

temperature.  Monthly values are allowed.  This parameter is visible only if Yes has been 
selected for domestic hot water parameter. 

 
Water set temperature is the temperature to which domestic water is to be heated.  Monthly 

values are allowed.  This parameter is used only if Yes has been selected for domestic hot 
water. 

 
Environment temperature is the temperature of the surroundings of the domestic water storage 

tank to which heat losses occur.  Monthly values are allowed.  This parameter is used only if 
Yes has been selected for domestic hot water. 

 
UA of auxiliary storage tank is the product of the energy loss coefficient and surface area for 

the auxiliary tank in the solar domestic water heating system.  In a single tank system, use the 
tank surface area above the heating element thermostat.  This parameter is visible only if Yes 
has been selected for domestic hot water. 

 
Heat exchanger water flow rate is the mass flow rate of water from the solar preheat tank to the 

air-water heat exchanger, used only if Yes has been selected for domestic hot water.  
 
Air-water heat exch effectiveness is the ratio of the actual heat transfer rate to the maximum 

possible heat transfer rate for the air-to-water domestic hot water heat exchanger.  This 
parameter is used only if Yes has been selected for domestic hot water. 

 
The thermal performance is calculated on a monthly basis.  The output (in English units) for the 

default parameters with 26 flat-plate collectors and cp =0.24 appears below.  
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Solar is the monthly total solar radiation incident on the collector surface. 
 
Heat is the monthly total space heating demand. 
 
Dhw is the monthly total water heating demand. 
 
Aux is the monthly total auxiliary energy required to supply the space and domestic water 

heating demands. 
 
f  is the fraction of the space and domestic water heating demands which is supplied by the solar 

energy system.  The remaining fraction must be met by an auxiliary source. 
 
 
4.5  Passive Direct-Gain Systems 
 
A schematic representation of a direct-gain system is shown in Figure 4.5.  During the month, 
solar energy strikes the window surface and some of this energy is transmitted through the 
window and absorbed within the building space.  The absorbed solar energy supplies some of the 
load, i.e., the energy required to maintain the building at the low thermostat set point 
temperature.  The load is the sum of the energy losses back out the direct-gain window and the 
losses (including infiltration) occurring from the rest of the building.  However, not all of the 
absorbed solar energy is useful in offsetting the load; some of the solar energy may be absorbed 
when the building space is at the high thermostat set point temperature.  In this case, the excess 
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energy will have to be removed to keep the building space from becoming uncomfortably warm.  
Alternatively, shades could be drawn to block the solar energy from entering the space.  The 
thermal performance of direct-gain passive systems is calculated using the Un-utilizability 
method of Monsen, Klein, and Beckman [1981].   
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Figure 4.5:  Passive Direct-Gain System 
 

 
The thermal parameters for direct-gain systems are listed below followed by their descriptions. 
 

 
 

Location is the location where the system is located.  Existing city data can be viewed or 
changed or data for a new city added from the Data pull down menu. 

 
Window area is the area of the direct-gain window.  
 
Number of glazings cycles through 1 to 4 and is used to calculate the angular dependence of the 

transmittance of solar radiation.  
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Window slope is the angle between the plane of the glazing and the horizontal.  A vertical 

window will have a 90° slope.  Monthly values are permitted. 
 
Window azimuth is the deviation of the normal to the direct-gain window from south.  A due 

south orientation will have an azimuth of 0 degrees.  Due west and due east will have values 
of 90 and -90, respectively.  Monthly values are permitted.  In the southern hemisphere a 
direct-gain window facing the sun at solar noon would have an azimuth angle of 180. 

 
Tau-Alpha (at normal incidence) is the product of the glazing transmittance and room wall 

absorptance for solar radiation at normal incidence.  Monthly values are permitted.  The solar 
absorptance, Alpha, of the direct gain window and the room can be estimated from  

            
Alpha = (1 - ρ)/(1 - ρ (1 - τ AreaW/AreaR)) 

where  
 ρ is the room wall solar reflectance  
  τ is the diffuse solar transmittance of the window 
  AreaW is the window area 
  AreaR is the surface area of all walls, floors and ceilings in the room. 
 
Daytime window conductance is the overall heat transfer coefficient per unit area between 

indoors through the glazing system to outdoors when night insulation is not in place.  This is 
the reciprocal of the window overall resistance.  Monthly values are permitted. 

 
Nighttime window conductance is the overall heat transfer coefficient per unit area between 

indoors through the glazing system to outdoors when night insulation is in place.  Insulation 
is assumed to be in place from sunset to sunrise.  This is the reciprocal of the window overall 
resistance.  Monthly values are permitted. 

 
Building UA is the building overall energy loss coefficient-area product NOT including the 

contribution of the passive element.  This parameter may have monthly values.  See Chapter 
25 of the ASHRAE Handbook of Fundamentals [1985] for additional information.   

 
Building storage capacity is the effective energy storage capacity of the building.  A value of 6 

BTU per square foot (123 KJ per square meter) of floor area is recommended for residential 
construction.  This parameter may have monthly values. 

 
Low thermostat set temperature is the temperature of the indoor space at which the auxiliary 

furnace turns on.   This parameter may have monthly values.  
 
Daily internal generation is the monthly-average daily energy generated within the building by 
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appliances, lights, people, and solar gains other than those attributed to the solar collector 
system.  This parameter may have monthly values.   

 
Allowable temperature swing is the number of degrees above the low set point temperature 

which the indoor space may be heated to before the solar collector fluid flow is terminated.  
This parameter may have monthly values.   

 
Fuel cycles through the four possibilities of the back-up fuel (Electricity, Gas, Oil, Other) where 

'Other' represents, for example, wood.  This parameter is used only in the economic 
evaluation.  

 
Efficiency of fuel usage represents the average furnace efficiency of the back-up (conventional) 

fuel.  This parameter is used in the economics calculations and it may vary monthly. 
 
An example of the output for the direct-gain system follows: 

 

 
 

Solar is the monthly total solar radiation incident on the exterior surface of the direct-gain 
window. 

 
Load is the monthly total space heating demand. 
 
Aux is the monthly total auxiliary energy required to maintain the indoor space above the low 

thermostat set point temperature 
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f is the fraction of the total load (including losses out the direct-gain window) which is supplied 

by the direct-gain system.  The remaining fraction must be met by an auxiliary source. 
 
 
4.6 Storage Wall Systems 
 
The monthly energy flows occurring in a passive storage wall system are represented in Figure 
4.6.  During the month, solar energy is transmitted through the glazings and absorbed on the 
storage wall.  The absorbed energy causes the outer wall temperature to rise and energy is then 
transmitted to the indoor space by conduction through the wall and via a convection loop through 
the gap between the wall and the glazings.  As with the direct-gain system, not all of the energy 
which enters the space is useful in offsetting the auxiliary energy consumption; some of the 
energy may actually have to be removed to keep the space from becoming uncomfortably warm.  
The Un-utilizability method of Monsen, Klein, and Beckman [1982] is used to evaluate the 
performance of passive storage wall systems.  
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Figure 4.6:  Passive Solar Wall System 
 

 
The thermal parameters for the passive storage wall system are listed below, along with the 
default values.  The parameter descriptions follow this list. 
 

.  
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Location is the location where the system is located.  Existing city data can be viewed or 
changed or data for a new city added from the Data pull down menu. 

 
Wall area is the surface area of the passive storage wall upon which solar radiation is absorbed. 
 
Number of glazings cycles through 1 to 4 and is used to calculate both the angular dependence 

of the transmittance of solar radiation and the resistance to heat transfer from the outdoors to 
the exterior surface of the passive storage wall. Monthly values are permitted. 

 
Wall slope is the angle between the plane of the wall and the horizontal.  A vertical wall will 

have a 90 degree slope. 
 
Wall azimuth is the deviation of the normal to the storage wall from south.  A due south 

orientation will have an azimuth of 0 degrees.  Due west and due east will have values of 90 
and -90, respectively.  In the southern hemisphere a direct-gain window facing the sun at 
solar noon (i.e. facing north) would have an azimuth angle of 180. 

 
Tau-Alpha (at normal incidence) is the product of the glazing transmittance and wall 

absorptance for solar radiation at normal incidence.  Monthly values are permitted. 
 
Wall thickness is the thickness of the solid portion of the passive storage wall (i.e., excluding 

the glazing or night insulation). 
 
Wall thermal conductivity is the thermal conductivity of the passive storage wall material.  

Properties of common building materials can be found in the ASHRAE Handbook of 
Fundamentals [1985] or in any heat transfer textbook. 

 
Wall density is the density of the passive storage wall material.  Properties of common building 

materials can be found in the ASHRAE Handbook of Fundamentals [1985] or in any heat 
transfer textbook. 

 
Wall specific heat is the specific heat of the passive storage wall material.  Properties of 
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common building materials can be found in the ASHRAE Handbook of Fundamentals [1985] 
or in any heat transfer textbook. 

 
Night insulation R-value is the thermal resistance of night insulation applied between the 

passive storage wall and outdoors.  This parameter may have monthly values. 
Building UA is the building overall energy loss coefficient-area product NOT including the 

contribution of the passive element.  This parameter may have monthly values.  See Chapter 
25 of the ASHRAE Handbook of Fundamentals [1985] for additional information.   

 
Building storage capacity is the effective energy storage capacity of the building.  A value of 6 

BTU per square foot (123 KJ per square meter) of floor area is recommended for residential 
construction.  This parameter may have monthly values. 

 
Low thermostat set temperature is the temperature of the indoor space at which the auxiliary 

furnace turns on.   This parameter may have monthly values.  
 
Daily internal generation is the monthly-average daily energy generated within the building by 

appliances, lights, people, and solar gains other than those attributed to the solar collector 
system.  This parameter may have monthly values.   

 
Allowable temperature swing is the number of degrees above the low set point temperature 

which the indoor space may be heated to before the solar collector fluid flow is terminated.  
This parameter may have monthly values.   

 
Fuel cycles through the four possibilities of the back-up fuel (Electricity, Gas, Oil, Other) where 

'Other' represents, for example, wood.  This parameter is used only in the economic 
evaluation of the system. 
 

Efficiency of fuel usage represents the average furnace efficiency of the back-up (conventional) 
fuel.  This parameter is used in the economics calculations and it may vary monthly. 
 
The output for the default values in English unit is as follows. 

 

 
56 

 



 
Chapter 4 

 

 
 

Solar is the monthly total solar radiation incident on the exterior glazing surface of the passive 
storage wall 

 
Load is the monthly total space heating demand 
 
Aux is the monthly total auxiliary energy required to maintain the indoor space above the low 

thermostat set point temperature 
 
f is the fraction of the total load (including losses out the storage wall) which is supplied by the 

solar system.  The remaining fraction must be met by an auxiliary source. 
 
 
4.7  Pool Heating Systems 
 
Pool solar heating calculations can be done for either indoor or outdoor pools as shown in Figure 
4.7.  The outdoor pool heating system can use solar energy in two ways.  Solar energy is 
absorbed directly by the water in the pool and it can be supplied by an optional solar collector 
system.  If a solar collector system is not being used, set Number of collector panels in the 
collector parameter set to 0.  Energy is lost from the pool by evaporation, convection, thermal 
radiation, and conduction to the ground.  The evaporation loss can be eliminated by a pool cover.  
The cover, however, reduces the amount of solar radiation absorbed by the pool.  Convection 
losses are  reduced when a bubble type cover is used.  The covers are assumed to be transparent 
to infrared radiation, so that radiation heat losses are not affected by the cover. This pool heating 
system will provide estimates of the monthly energy loss from the pool  based on the algorithms 
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described by Sigworth et al. [1979].  If this information is already known from previous pool 
heating energy use, the general solar heating system of Section 4.7 is an alternative way to 
estimate the contribution from a solar collector system.  
 

 

COLLECTOR

TO 

FROM 

Figue 4.7:  Pool Heating System 
 

 
The thermal parameters for the pool heating system are listed below along with default values.  
The parameter descriptions follows. 
 

 
 

Location is the location where the system is located.  Existing city data can be viewed or 
changed or data for a new city added from the Data pull down menu. 
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Pool surface area is the surface area of the pool water. 
 
Pool temperature is the monthly average desired pool temperature.  It is assumed that the 

auxiliary pool heating system has sufficient capacity to maintain the pool at this temperature.  
This parameter can vary monthly. 

 
First month of season can be cycled through all months of the year to select the month that pool 

usage (and heating) begins.  It is assumed that heating begins on the first day of the selected 
month. 

 
Last Month of Season can be cycled through all months of the year to select the month that pool 

usage (and heating) ends.  It is assumed that pool heating ends on the last day of this month. 
 
Cover cycles through 'None', 'Film' and 'Bubble' indicating the type of pool cover, if any.  The 

fraction of the solar energy incident on the pool surface that is absorbed by the pool water 
when no cover is used is assumed to be 0.855.  A film cover eliminates all evaporation losses 
when in place and has 0.837 of the incident solar radiation absorbed by the pool.  A bubble-
type pool cover eliminates evaporation and reduces convective losses.  The fraction of the 
incident solar radiation absorbed by the pool when the bubble-type cover is in place is 
assumed to be 0.783.  The R-value for the bubble-type cover is assumed to be 1.87 hr-ft2-
F/Btu (0.33 m2-C/W). 

 
Hours per day covered is the average number of hours per day that the pool cover is in place.  

This parameter can vary monthly. 
 
Average pool depth is multiplied by the pool area to determine the pool volume. 
 
Location (Indoor, Outdoor) toggles to specify the location of the pool.  If the pool is indoors, 

then the humidity and temperature of the controlled indoor space must be specified.  The 
pool calculations do not include energy to condition the indoor space. 

 
% of time shaded (Outdoor) is the percentage of solar radiation incident on an unobstructed 

horizontal surface which is incident on the outdoor pool surface.  This parameter can be used 
to estimate the effects of nearby buildings or trees or it can be used to modify the assumed 
cover transmittance and pool absorptance.  This parameter can vary monthly. 

 
Average wind speed (Outdoor) is the average wind speed at the outdoor pool surface.  The 

wind speed at a local meteorological station is often significantly higher than the average 
wind speed at a pool surface.  Sigworth et. al. [1979] recommend that, for a well-protected 
pool, the wind speed reported by the weather bureau be reduced by a factor of 10.  For a 
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moderately protected pool, they recommend a factor of 5.  This parameter can vary monthly. 

 
Pool room relative humidity is the average relative humidity of the conditioned space in which 

the indoor pool is located.  Energy calculations for the pool system do not include energy to 
maintain the pool room conditions.  This parameter can vary monthly. 

 
Pool room temperature is the average temperature of the conditioned space in which the indoor 

pool is located.  Energy calculations for the pool system do not include energy to maintain 
the pool room conditions.  This parameter may have monthly values. 

 
Fuel cycles through the four possibilities of the back-up fuel (Electricity, Gas, Oil, Other) where 

'Other' represents, for example, wood.  This parameter is used only in the economic 
evaluation of the system. 

 
Efficiency of fuel usage represents the average furnace efficiency of the back-up (conventional) 

fuel.  This parameter is used in the economics calculations and it may vary monthly. 
 
Pipe heat loss (Yes, No) toggles to indicate if the following two parameters are to be used to 

calculate the effect of pipe heat losses.  If No is selected, the following two parameters are 
ignored. 

 
Inlet pipe UA is the overall loss coefficient-pipe area product for the pipe carrying fluid to the 

collector array.  This parameter is used only if Yes has been selected for pipe heat loss. 
 
Outlet pipe UA is the overall loss coefficient-pipe area product for the pipe carrying fluid from 

the collector array.  This parameter is used only if Yes has been selected for pipe heat loss. 
 
The output for the default values in English units is as follows. 
 

 
 

Q Coll is the monthly solar energy delivered by the solar collectors to the pool. 
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Q Pool is the monthly solar energy directly absorbed by the pool. 
 
Load is the monthly energy loss from the pool by evaporation, convection, thermal radiation, 

and ground conduction minus the absorbed solar radiation (Qpool). 
 
Aux is the monthly energy that must be supplied by the backup pool heater to maintain the pool 

temperature at the specified value. 
 
f is the fraction of the pool heating demand which is supplied by the solar collector system.  

Direct absorption of solar radiation (for outdoor pools) is considered as a reduction to the 
pool heating load. 

 
Pool T is the monthly average temperature of the pool.  If the heater capacity is sufficiently 

large, then the pool temperature will be equal to the second parameter, the Pool temperature.  
If the heater capacity is not sufficient to maintain the pool temperature at the desired setting 
then the pool will reach an equilibrium temperature which balances the input energy from the 
sun and solar system with the pool losses. 

 
 

4.8  General Solar Heating Systems 
 

The solar energy system shown in Figures 4.2 and 4.8 represent the general classes of closed and 
open-loop solar energy systems which can be used for a variety of applications including space 
heating, absorption air conditioning, water heating and process heating.  Solar energy is collected 
and stored as sensible heat in a liquid storage tank.  The storage tank is assumed to be 
pressurized or filled with a liquid having a high boiling point so that energy dumping (i.e., 
energy loss through the pressure relief valve) does not occur.  When required, the heated liquid is 
either pumped from storage through a heat exchanger to supply thermal energy to the load 
(closed-loop system) or the fluid is removed from the tank and replaced with cold fluid (open-
loop system). The load is a demand for energy above a minimum useful temperature, TMIN.  
The value of TMIN depends on the application.  For residential space heating, TMIN is the 
indoor temperature of the building, which is about 20 C.  All energy above 20 C can be used for 
space heating.  There are other space heating applications for which TMIN may be higher or 
lower than 20 C, as, for example, the solar heating of a warehouse which is to be maintained at 
10 C.  In a water heating system, TMIN will be the mains supply water temperature.  TMIN for 
industrial processes or air conditioning applications will depend on the particular installation.  
Auxiliary energy is supplied if the solar energy is insufficient to meet the load.  
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     at  
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Closed-Loop Solar Energy System Figure 4.8: 
 

 
The thermal performance of these general solar heating systems is calculated using the PHIBAR, 
f-Chart ( , f chartφ − ) method of Klein and Beckman [1979] which has been extended to open-
loop systems as described by Braun and Klein [1983].  The thermal parameters and default 
values are listed below followed by descriptions of the parameters. 
 

 
 

Location is the location where the system is located.  Existing city data can be viewed or 
changed or data for a new city added from the Data pull down menu. 

 
Average daily energy use is the monthly average daily energy demand of the process.  This 
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energy demand is met by a combination of solar energy and conventional energy.  This 
parameter may have monthly values. 

 
Average daily load flow is the average daily amount of stored fluid circulated (or removed) to 

supply the load.  In a closed-loop system, this will be the product of the rate at which fluid is 
circulated through the load heat exchanger and the average number of hours per day in which 
there is a load.  In an open-loop system, this is average daily amount of fluid removed from 
the tank. This parameter may have monthly values. 

 
Load heat exchanger effectiveness is the ratio of the actual to maximum heat transfer rates in 

the heat exchanger between the solar storage tank and the load in a closed-loop system.  For 
an open-loop system, a heat exchanger does not exist and this parameter should be set equal 
to 1.0. 

 
Minimum useful temperature is the lowest temperature in which energy supplied to the load is 

useful.  Monthly values are permitted. 
 
Liquid storage tank volume is the volume of stored liquid used for sensible heat storage of 

collected solar energy. 
 
Tank liquid specific heat is the specific heat of the liquid in the storage tank.  Properties of 

common materials can be found in the ASHRAE Handbook of Fundamentals [1985] or in 
any heat transfer textbook.  For water, use 1 Btu/lbm F or 4190 J/kg-K. 

 
Tank liquid density is the density of the liquid in the storage tank.  Properties of common 

materials can be found in the ASHRAE Handbook of Fundamentals [1985] or in any heat 
transfer textbook.  For water use 62.4 lbm/ft3 or 1000 kg/m3. 

 
UA of solar storage tank is the product of the energy loss coefficient and surface area for the 

solar storage tank. 
 
Tank environment temperature is the temperature of the surroundings of the storage tank to 

which heat transfer losses occur.  Monthly values are permitted. 
 
Fuel cycles through the four possibilities (Electricity, Gas, Oil, Other) of the back-up fuel where 

'Other' represents, for example, wood.  This parameter is used only in the economic 
evaluation.  

 
Efficiency of fuel usage represents the average furnace efficiency of the back-up (conventional) 

fuel.  This parameter is used in the economics calculations and it may vary monthly. 
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Pipe heat loss toggles between Yes and No to indicate if the following two parameters are to be 

used to calculate the effect of pipe heat losses.  If No is selected, the following two 
parameters are ignored. 
 

Inlet pipe UA is the overall loss coefficient-pipe area product for the pipe carrying fluid to the 
collector array.  This parameter is used only if Yes has been selected for pipe heat loss. 
 

Outlet pipe UA is the overall loss coefficient-pipe area product for the pipe carrying fluid from 
the collector array.  This parameter is used only if Yes has been selected for pipe heat loss. 

 
Collector-store heat exch toggles between Yes and No to indicate if the following two 

parameters should be used to account for the performance penalty resulting from the heat 
exchanger between the collector array and the storage tank.  If No is specified, the following 
two parameters are ignored.] 

 
Tank side flow rate/area is the mass flow rate of water from the storage tank through the 

collector-storage heat exchanger divided by the total array area.  Set this parameter to a value 
that is larger than collector flow rate/area for an internal heat exchanger.  This parameter is 
used only if Yes is selected for the collector-storage heat exchanger. 
 

Heat exchanger effectiveness is the ratio of the actual to maximum possible heat transfer rates 
for heat exchanger located between the collector and the storage unit.  This parameter is used 
only if Yes is selected for the collector-storage heat exchanger. 

 
The output for the default values (which represents a process heating system) in English units is:  
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Solar is the monthly total solar radiation incident on the collector surface. 
 
Load is the monthly total thermal energy demand on the system at a temperature above the 

specified minimum useful temperature. 
 
Q Tank is the monthly total energy loss from the storage tank. 
 
Aux is the monthly total auxiliary energy which must be supplied in addition to the solar energy 

to meet the demand. 
 
f is the fraction of the load supplied by the solar energy system.  The remaining fraction is 

supplied by an auxiliary source. 
 
 

4.9  Integral Collector-Storage Water Heating Systems 
 
Integral collector-storage (ICS) units are passive solar water preheaters that combine solar 
collection with thermal storage.  They are usually roof or ground mounted in series with a 
conventional domestic water heater and supplied by mains water.  An ICS unit is basically a 
black tank in an enclosure with an optical cover system, as shown in Figure 4.8.  There are many 
variations in design.  Some units have several tanks plumbed in series within the enclosure.  
Others have internal reflector systems, non-flat covers or finned tanks.  ICS solar water heaters 
usually cost less than active systems and are inherently simple to install and maintain.  They 
often operate without heat exchangers, pumps or controllers.  Auxiliary energy must be supplied 
if the solar energy collected by the ICS system is insufficient to meet the water heating load. 
 

 

Figure 4.9: Integral Collector-Storage Solar Water Heater 

COLLECTO

 
 

The monthly performance of an ICS system is estimated using the method of Zollner et al. 
[1985].  The thermal parameters and default values in English units are listed below followed by 
descriptions of the parameters. 
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Location is the location where the system is located.  Existing city data can be viewed or 
changed or data for a new city added from the Data pull down menu. 

 
No. of units tested is the number of integral collector-storage units used in the SRCC test.  

NOTE: This parameter should not be changed without supplying modified values of the 
SRCC heat loss coefficient and SRCC net energy delivered. 

 
Glazing area per unit is the aperture area of each ICS unit panel.  NOTE: This parameter 

should not be changed without supplying modified values of the SRCC heat loss coefficient 
and the SRCC net energy delivery. 

 
SRCC heat loss coefficient is the overall integral collector-storage unit heat loss coefficient 

resulting from the nighttime cool-down test as prescribed by SRCC Standard 200. 
 
SRCC net energy delivery is the periodic steady value of the daily useful energy collected by 

the integral collector-storage system obtained from the ASHRAE 95-1981 test procedure 
under simulated environmental conditions as prescribed by SRCC Standard 200. 

 
Collector slope is the angle between the plane of the collector aperture and the horizontal.  This 
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parameter may have monthly values.  The angle is measured in a vertical plane that is 
perpendicular to the line formed by the intersection of the plane of the collector aperture and 
the horizontal plane. 
 

Collector azimuth (South=0) is the angle between the projection into the horizontal plane of the 
normal to the collector aperture and the local meridian with the zero point directly facing the 
equator, west positive, and east negative.  The azimuth of a horizontal collector can have any 
value.  The azimuth of a collector facing the sun at noon in the southern hemisphere (i.e. 
north facing) is 180.  This parameter may have monthly values. 
 

Incidence angle modifier calculation cycles through 'Glazings', 'Constant', and 'Value(s)' to 
indicate which of three possible methods is to be used to calculate the effect of incidence 
angle on FR*TAU*ALPHA.  One of the next three parameters will be available depending 
upon the selection; the other two will be hidden.  If 'Glazings' is selected, the Fresnel 
equations are used with nominal glass properties and the number of glazings will have to be 
selected.  If 'Constant' is selected, the ASHRAE incident angle modifier constant will be 
required.  If 'Value(s)' is selected, either a single incidence angle modifier or the incident 
angle modifier value for every 10 degrees will be required. 
 

Number of glazings cycles through 1 to 4 to indicate the number of glazings on the solar 
collector.  Values of the monthly-average incidence angle modifier are calculated using the 
Fresnel equations with glass properties and the method described in Duffie and Beckman 
[1980]. 
 

Inc angle modifier constant, b, is the parameter which provides the best fit in the equation K(t) 
= 1.0 - b (1/cos(t) - 1.0) where K(t) is the ratio of the transmittance-absorptance product at 
incidence angle t to the normal incidence transmittance-absorptance product.  The constant, 
b, is determined experimentally as described in the ASHRAE Standard 93-77 collector test 
procedure [1977].  This parameter is visible only if 'Constant' was chosen for the incidence 
angle modifier type. 
 

Inc angle modifier value(s) are the the value(s) of the collector incidence angle modifier, K(t) 
as determined by the ASHRAE Standard 93-77 collector test procedure [1977].  If a single 
value is used for this parameter, then the incidence angle modifier is taken to be that constant 
value independent of solar incidence angle.  Alternatively, values of this parameter may be 
specified for incidence angles between 0 and 90 degrees in 10 degree increments.  The 
incidence angle value(s) are used only if 'Value(s)' was chosen for the incidence angle 
modifier type. 
 

Fuel cycles through the four possibilities (Electricity, Gas, Oil, Other) of the back-up fuel where 
'Other' represents, for example, wood.  This parameter is used only in the economic 
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evaluation.  

 
Efficiency of fuel usage represents the average furnace efficiency of the back-up (conventional) 

fuel.  This parameter is used in the economics calculations and it may vary monthly. 
 

Daily hot water usage is the average amount of hot water per day required at the set 
temperature.  Monthly values are allowed.  This parameter is visible only if Yes has been 
selected for domestic hot water parameter. 

 
Water set temperature is the temperature to which domestic water is to be heated.  Monthly 

values are allowed.  This parameter is used only if Yes has been selected for domestic hot 
water. 
 

ICS unit tank volume is the volume of the integral collector-storage unit. 
 
UA of auxiliary storage tank is the product of the energy loss coefficient and surface area for 

the auxiliary tank in the solar domestic water heating system.  In a single tank system, use the 
tank surface area above the heating element thermostat.   

 
Auxiliary environmental temperature is the temperature of the surroundings of the auxiliary 

water heater to which heat losses occur.  Monthly values are allowed. 
 
First month of use cycles through the 12 months to indicate the month of the year in which the 

integral collector-storage unit will be put into operation.  It is assumed operation begins on 
the first day of the month. 

 
Last month of use cycles through the 12 months to indicate the last month of the year in which 

the integral collector-storage unit will be operating.  It is assumed operation stops on the last 
day of the month. 

 
The thermal performance is calculated on a monthly basis.  Shown below is the output for the 
default parameter set in English units. 
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Solar is the monthly total solar radiation incident on the collector surface. 
 
Load is the monthly domestic hot water energy demand. 
 
Loss is the monthly energy loss from the auxiliary storage tank. 
 
Aux is the monthly total auxiliary energy required to supply the domestic hot water demand. 
 
f is the fraction of the hot water energy demand which is supplied by the ICS system. 
 
Optical efficiency is the effective product of the glazing transmittance and tank absorptance. 
 
Energy Loss Coefficient is the effective energy loss coefficienct of the ICS system to the 

ambient expressed per unit glazing area. 
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C H A P T E R  5  
 _____________________________________________________________________________________________ 

Economics _____________________________________________________________________________________________  
 
 

The economic calculations done in F-Chart are first year costs, life cycle, life cycle savings and 
cash flow. Life cycle costs and savings are computed from present costs of energy from fuel and 
its anticipated inflation rate, market discount rate, an assumed period of economic analysis, 
owning costs and operating costs.  The life-cycle costs of owning and operating the improvement 
includes such items as interest and principle payments on funds borrowed to pay for the 
improvement (e.g., on the incremental mortgage), income tax effects of incremental property 
taxes and interest payments, tax credits, resale value, depreciation, etc.  In this chapter, we 
discuss the meaning of the economic output and discuss each of the economic parameters.  The 
life cycle cost method as applied to solar energy systems can be found in Duffie and Beckman 
[1991]. 
 
 
5.1  Economic Parameters 
 
The economic parameter list contains 28 parameters.  Two additional economic parameters are 
contained in the system parameter list:  the fuel type and the efficiency of fuel usage.  These two 
parameters are explained in the appropriate places in Chapter 4.  The economic parameter list 
and explanations of the parameters follow. 
 

 
 

 
70 
 



 
Chapter 5 

 
 

 
 

Economic analysis detail cycles through "Brief", "Detailed", and "Cash Flow".  The Brief 
selection gives economic information about the first year, the life cycle costs, and the life 
cycle savings.  The Detailed option includes the information given under the Brief selection 
and, in addition, gives information on the breakdown of the life cycle economic costs.  The 
Cash Flow option includes all of the above and gives the annual cash position.  

 
Cost per unit area is the cost per square foot or square meter of the solar collection system 

including such items as the storage costs that increase with increasing collector area.  If the 
total cost of the system is known, then set this parameter to zero and place the total cost into 
the "Area independent cost" parameter.  For a passive system, this unit area cost should be 
only the incremental cost of the wall above the conventional wall.  If this cost is less than a 
conventional wall then use a negative cost per unit area. 

 
Area independent cost is the cost of fixed equipment such as pumps, controllers, piping, part of 

the storage, and other costs that are independent of collector area.  If the total cost of the 
system is known, then set this parameter to the total cost and place a zero in the "Cost per 
unit area" parameter. 

 
Price of electricity is the average purchase price per kilowatt-hour paid in the first year. 
 
Annual % increase in electricity is the anticipated average yearly inflation rate of electricity 
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during the period of the economic analysis.  It is assumed that the average rate occurs each 
year of the analysis.  

 
Price of natural gas is the average purchase price per 100 cubic feet (approximately per therm) 

or per cubic meter paid in the first year. 
 
Annual % increase in nat. gas is the anticipated average yearly inflation rate of gas during the 

period of the economic analysis.  It is assumed that the average rate occurs each year of the 
analysis.  

 
Price of fuel oil is the average purchase price per gallon or per liter paid in the first year. 
 
Annual % increase in fuel oil is the anticipated average yearly inflation rate of oil during the 

period of the economic analysis.  It is assumed that the average rate occurs each year of the 
analysis.  

 
Price of other fuel such as wood is the average purchase price per million BTU or per gigajoule 

paid in the first year. 
 
Annual % increase in other fuel is the anticipated average yearly inflation rate of heating fuel 

such as wood during the period of the economic analysis.  It is assumed that the average rate 
occurs each year of the analysis.  

 
Period of economic analysis is the number of years over which the life cycle cost analysis is 

done.  Often this is 20 years or the same as the term of the mortgage. 
 
Percent down payment is the percentage of the incremental cost of the solar system which is 

paid out at the time of installation.  The balance is paid for by a mortgage. 
 
Annual mortgage interest rate is the yearly rate charged by the lender on funds borrowed, in 

percent. 
 
Term of the mortgage is the number of years over which the funds borrowed must be repaid. 
 
Annual market discount rate is the yearly rate of return from the solar system owner's best 

alternative investment, in percent.  For a home owner, this is often the interest rate available 
at a bank, either the savings account rate or the rate for certificates of deposit (CD's).  For a 
business, the internal rate of return of the company is often used.    

 
% Extra insur. and maint. in year 1 is the first year's extra insurance, maintenance, and other 

non-fuel operating expenses attributable to the system, expressed as a percent of the initial 

 
72 

 



 
Chapter 5 

 
investment. 

 
Annual % increase in insur. and maint. is the average expected inflation rate of these 

expenses (previous parameter) over the period of the economic analysis.   
 
Eff Fed.+State income tax rate is the effective combined federal and state income tax rate of 

the solar system owner.  If tax laws do not permit deducting of state taxes on federal returns 
(e.g., if the owner uses standard deductions on his/her federal return) then this parameter is 
the sum of the federal and state brackets, in percent.  If state taxes are deducted from federal 
income for tax purposes, then the effective rate is the sum of the federal and state rates minus 
their product.   

 
True % property tax rate is the ratio of the increment in real estate taxes due to the solar 

system to the cost of the solar system (not the assessed tax value of the solar system), 
expressed as a percent.  Some taxing districts specifically exempt solar systems in which case 
this parameter should be zero. 

 
Annual % increase in property tax is the anticipated average yearly rate of inflation of 

property taxes over the period of the economic analysis, in percent.  This is often set equal to 
the general inflation rate. 

 
% Resale value is the anticipated resale or salvage value of the solar system at the end of the 

period of the economic analysis, as a percent of the initial solar system cost.  If the solar 
system were added to a house and treated like any other part of the house, the percent resale 
value would be equal to the ratio of the house selling price at the end of the economic 
analysis divided by the house purchase price.  If the solar system were worn out and needed 
replacement at the end of the economic period, then the resale value would be negative and 
equal to the removal cost divided by the initial solar system cost.  These two limits probably 
bracket the actual situation.  If the period of the economic analysis is long, say 20 years or 
more, then the resale value will have only a small effect on the life cycle cost.    

 
% Credit Rate in tier 1 
Maximum investment in tier 1 
% Credit Rate in tier 2 
Maximum investment in tier 2 
These four parameters are provided to enter tax credits or government subsidies that effectively 

reduce the purchase price of the solar system.  Since some solar systems may be subsidized 
by more than one government agency, provision has been made to consider credits from two 
agencies with different limits of eligibility.  Consider a state government with a tax credit of 
25% on the first $2000 of investment and a federal government with a 40% credit on the first 
$10000 of investment.  The credit on the first $2000 would be 65% and the credit on the next 
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$8000 would be 40%.  The percent credit rate in tier one is 65%.  The maximum investment 
in tier one is $2000.  The percent credit in tier two is 40%.  The maximum investment in tier 
2 is $10000.  

 
Commercial system? toggles between "Yes" and "No" to indicate if the solar system can be 

depreciated for tax purposes and if fuel is deductible as a business expense.  If this parameter 
is set to "Yes", then the depreciation schedule in the next parameter is used in calculating 
taxes and fuel is assumed to be deductible as a business expense.  (For a business that makes 
a profit and pays taxes, the government subsidizes fuel).  Consequently, commercial solar 
energy systems are harder to justify on economic grounds than residential or other non-profit 
solar systems.)  If fuel is deductible, but depreciation is not allowed, set this parameter to 
"Yes" and set the depreciation schedule to zero.  If depreciation is allowed but fuel is 
specifically not allowed as a business expense, set this parameter to "Yes" and artificially 
increase the fuel cost by the effective income tax bracket.  For solar systems on private 
homes, this parameter should be set to "No".  

 
Commercial depreciation schedule is applicable only if the commercial system parameter is set 

to "Yes".  In this case, then you may enter 10 yearly depreciation values that effect the taxes 
paid.  For a three-year depreciation schedule, the U.S. Government allows 25%, 38%, and 
37%.  For a five-year schedule, the rates are 15%, 22%, 21%, 21% and 21%.  For a ten-year 
schedule, the rates are 8%, 14%, 12%, 10%, 10%, 10%, 9%, 9%, 9% and 9%. 

 
 
5.2 Economics Output 
 
The level of detail displayed for the economic calculations is controlled by the first parameter in 
the economic parameter window.  The economics output resulting from the Brief setting is as 
follows: (Using the file DEFAULTS.FC) 
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First year fuel cost is calculated by multiplying the cost per unit of auxiliary energy by the 

annual auxiliary requirements determined in the thermal analysis and dividing this result by 
the fuel usage efficiency.   

 
First year fuel savings plus the first year fuel cost is equal to the non-solar fuel cost.    
 
Initial investment is calculated by multiplying the cost per unit area by the area and adding the 

fixed cost.   
 
Life cycle savings are calculated by subtracting the present worth of the owning and operating 

costs from the present worth of the fuel savings, both calculated for the period of the 
economic analysis.  This savings represents the economic advantage of the system over a 
fuel-only system.   

 
Life cycle costs is the sum of the present worth of the fuel cost and the owning and operating 

cost.  A breakdown of the life cycle costs is provided. 
 
When the economics analysis detail is set to Detailed, all of the above information will be 
presented along with a breakdown of equipment costs into expenses and credits.  
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The Down Payment is assumed to be made at the beginning of the first year and is therefore not 
discounted.  The Mortgage cost is the present worth of the sum of the annual mortgage 
payments.  Maintenance and insurance costs are the sum of the present worth of the inflating 
annual payments.  Property taxes are also calculated as the sum of the present worth of the 
inflating annual payments.  However, property taxes are a net cost since income tax deductions 
have been included.  Interest represents the tax benefit resulting from including the mortgage 
interest as a deduction on federal and state income tax forms.  Depreciation is the present worth 
of the depreciation, calculated according the Commercial depreciation schedule, for income 
producing buildings.  Resale is the present worth of the product, which is the % Resale value 
times the initial investment.  For commercial property, the resale value is reduced by tax 
considerations. The Tax credits from federal and state governments are calculated if Consider 
Rebates is set to Yes.  
 
Setting the economic analysis detail to Cash Flow provides, in addition to the outputs for the 
detailed setting, the annual cash position for each year of the economic analysis which appears as 
follows.  
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Maint & Ins is the annual expense to maintain and insure the equipment. 
 
Prop Tax is the annual property tax.  
 
Energy Cost is the annual payment made for auxiliary fuel. 
 
Tax Savings is the annual saving due to state and federal tax deductions. For non-commercial 

systems, this term includes property taxes and interest.  For commercial systems, 
maintenance, insurance and fuel are tax deductible and these savings are included in this 
term. In year 0, this column includes any additional state and federal rebates. 

 
Net Savings is the difference between the annual expenses incurred without a solar system and 

the expenses incurred with a solar system. In year 0, this term is the difference between the 
down payment and the tax rebates. 

 
Present Worth is the present worth of the Net Savings column.  The total of the Present Worth 

column is equal to the life cycle savings.  
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SI UNITS 
 
 Basic Units Derived units 
  
 meter m length liter l volume 10-3m3 
 kilogram kg mass Newton N force kg-m/s 
 second s time Joule J energy N-m 
 Kelvin K temperature Watt W power J/s 
    Hour hr time 3600 s 

Decimal Multiples of Units 
  
 tera T 1012 
 giga G 109 
 mega M 106 
 kilo k 103 
 micro m 10-3 
 nano n 10-9 
 pico p 10-12 

 
UNIT CONVERSIONS 

 
 Length Velocity 
  
 1 ft  = 0.3048 m 1 ft/min  = 0.00508 m/s 
 1 mile  = 1.6093 m 1 mile/hr  = 0.44704 m/s 
 1 inch  = 25.4 mm  
  1 yard  = 0.9144 m 
  
 
 Area 
 
 1 ft2  = 0.092903 m2 
 1 mile2  = 2.58999 km2 
 1 inch2  = 0.000645 m2 
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 Volume Volumetric Rate 
  
 1 ft3  = 28.3168 l 1 cfm  = 0.47195 l/s 
 1 gal  = 3.78544 l 1 gal/min  = 0.06309 l/s 
 1 ft3 = 7.48 gal 1 gal/min-ft2 = 0.6791l/s-m2 
  1 yard3 = 0.7645 m3 1 cfm/ft2 = 0.1968 l/s-m2 
  
. 
 Mass Mass Flow Rate 
 
 1 lb = 0.453492 kg 1 lb/hr = 0.000126 kg/s 
 1 oz = 28.3495 g 1 lb/hr-ft2 = 0.001356 kg/s-m2 
 
 Temperature Scales  Temperature Differences 

 
 F = C x 1.8 + 32 1 F  = 0.55556 C 
 C  = (F-32) x 5/9 1 C  = 1.8 F 
 K = C + 273  
 R = F + 460 
  
 Energy Power 
 
 1 Btu   = 1.05506 kJ    1 Btu/hr  = 0.29307 W 
 1 Therm   = 105.506 MJ 1 ton (refg) = 3.51685 kW 
 1 cal  = 4.1868 J 1 kcal/hr = 1.163 W 
 1 kW-hr  = 3.6 MJ 1 hp = 0.74570 kW 
 1 langley = 41.86 kJ/m2 
  
 Energy Flux 
  
 1 Btu/hr-ft2   = 3.15469 W/m2 
 1 langley/hr  = 11.6277 W/m2 
 1 cal/cm2-min = 697.4 W/m2 
 1 Btu /hr-ft2-F = 5.67826 W/m2-C 
 1 Btu /hr-ft-F = 1.70307 W/m2-C  
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NUMERICAL VALUES OF SOME PROPERTIES 

  
 Solar Constant  = 1353 W/m2 
  = 1.940 langleys/min 
  = 428 Btu/hr-ft2 
 
 Density Specific Heat 
 
 Air 1.204 kg/m3  1012 J/kg-C 
  0.07516 lb/ft3  0.241 BTU/lb-F 
 
 Water 1000 kg/m3  4190 J/kg-C 
  62.4 lb/ft3  1.00 BTU/lb-F 
  8.34 lb/gal 
 
 Rock 2400 kg/m3  838 J/kg-C 
  150 lb/ft3  0.2 BTU/lb-F 
  
 Antifreeze 1065 kg/m3  3350 J/kg-C 
  (50% Ethylene 66.5 lb/ft3  0.80 BTU/lb-F 
  glycol-water) 
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California Compliance Requirements _____________________________________________________________________________________________  
 
 

The state of California has special requirements for showing compliance with Title 24, Part 2, 
Chapter 2-53, Section 2-5351.  This appendix has been prepared from the appropriate documents 
for F-Chart users in California.  
 
When calculating solar domestic hot water performance, the Water Storage Space & DHW 
system should be selected from the System menu.  The Building UA must be set to zero to turn 
off the house heating option and the Domestic hot water option must be set to Yes.  Some of the 
F-Chart parameters and weather data have to be set according to the California code. The 
storage tank is initially assumed to be perfectly insulated so that UA of auxiliary tank must be set 
to zero.  A special calculation method is used to estimate standby losses and is included in the 
calculation procedure outlined below.  The Water set temperature must be set to 140 F.  The 
Daily hot water usage must be set to 50 gal/day/unit for single family dwellings or to 35 
gal/day/unit for multi-family dwellings.  
 
Weather data for the 16 California climate zones have been added to the F-Chart database using 
data supplied by the California Energy Commission.  The data for those cities that are in both the 
original F-Chart database and the CEC database are not the same.  The F-Chart database, 
USA_Old, comes from a 1978 DOE report, Input Data for Solar Systems by V. Cinquemani, J.R. 
Owenby, Jr. and R.G. Baldwin (prepared under interagency agreement no E(49-26)-1041).  The 
F-Chart database USA_New comes from the National Solar Radiation DataBase (NSRDB) 
created by the National Renewable Energy Laboratory (NREL). 
 
The CEC calculation procedure for estimating the total water heating energy is reproduced here. 
The tables needed to fill in the worksheet are also provided.  Table 1 lists the 16 climate zones, 
the F-Chart city number, the storage tank environment temperature for Parameter 9, the water 
mains temperature and the number of freeze days per year.  The F-Chart Chg/View Data 
command in the Weather menu will have to be used to change the water mains temperatures to 
the values found in Table 1.  Table 2 gives estimates of pump and controller annual energy use.  
Table 3 gives the standby loss adjustment.    
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CALCULATION OF ANNUAL WATER HEATING ENERGY 

  
A.  Equipment Data 
  
  1. Tank capacity _______  Gal From CEC Appliance Directory 
  2. Recovery efficiency  _______  Percent From CEC Appliance Directory 
  3. Hourly input rate    _______  Btu/hr. From CEC Appliance Directory 
  4. Pumping energy       _______  Watt-hr/yr See Table 2. 
  
B. Operating Data 
  
  1. Tank set temp.           140  F              Fixed input 
  2. Water main temp.     _______  F              See Table 1 
  3. Daily water load     _______  Gal/day        Single family=50 gal/day 
    Multi-family =35 gal/day 
  4. Environment temp.    _______  F              See Table 1 
  5. Adj. standby loss   _______  Percent        See Table 3 
  
C. Water Heating Energy 
  
  1. Annual recovery load _______  KBtu/yr        B3 x 8.25 x (140-B2) x 365/1000 
  
  2. Energy from non-                           
 depletable resources _______  KBtu/yr        F for yr x DHW load for yr 
    from F-Chart output 
  3. Net annual recovery 
 load  _______  KBtu/yr        C1-C2 
  4. Annual recovery 
 energy     _______  KBtu/yr        C3/A2 
  5.  Annual standby 
 loss energy       _______  KBtu/yr        (24-(C4 x 1000)/(A3 x 365)) x 
    8.25 x A1 x B5 x 365 x (140-B4)/1000 
  
  6. Pumping energy       _______  KBtu/yr        A4 x 3.414 x 3/1000 
  7. Total water heating 
 energy  _______  KBtu/yr        C4+C5+C6 Gas systems or 
    ((C4+C5)x3)+C6 for all electric systems 
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TABLE 1.:  California Climate Zone  Modeling Variables 
 
 CEC ------Temperatures------ Number of 
 Zone City Lat. Environment Water Mains Freeze Days 
 1  Arcata 41.0 52.1 60 5 
 2  Santa Rosa 38.5 57.9 65 16 
 3  Oakland 37.7 56.9 65 1 
 4  Sunnyvale 37.4 60.3 65 8 
 5  Santa Maria 34.9 60.3 65 24 
 6  Long Beach 33.8 63.5 70 1 
 7  San Diego 32.7 62.9 70 1 
 8  El Toro AFB 33.7 73.0 70 1 
 9  San Fernando 34.3 63.6 70 1 
 10  Riverside 33.9 63.3 70 14 
 11  Red Bluff 40.2 62.8 65 22 
 12  Sacramento 38.5 60.3 65 17 
 13  Fresno 36.8 62.3 65 28 
 14  China Lake AFB 35.7 55.9 65 124 
 15  El Centro 32.8 72.6 70 22 
 16  Mount Shasta 41.3 42.8 60 130 
 
 
If a solar system is being installed, pump and control energy must be determined for the 
particular generic solar system type. This energy can be determined from the fixed values listed 
below.  Other values are allowed if verification of pump and controller wattage is provided to the 
local building department.   

 
85 
 



 
Appendix C 

 
 
 TABLE 2. Determining Pumping Energy 

 
 System Type Pump and Control Energy 
    (Watt-hr/yr) 
___________________________________________________________________ 
Open-loop (direct) 
 Recirculation  -   85W pump @ 6 hrs/day             See * below 
  5W controller @ 24 hrs/day 
  
 Draindown      -   85W pump @ 6 hrs/day             247, 470 
  5W controller @ 24 hrs/day 
  2W draindown valve @ 24 hrs/day 
  
Closed-loop (indirect) 
 Drainback      -   85W pump @ 6 hrs/day             470, 850 
  70W pump @ 6 hrs/day 
  15W controller @ 24 hrs/day 
  
 Anti-freeze    -   85W pump @ 6 hrs/day  229, 950 
  5W controller @ 24 hrs/day 
  
 Oil -   185W pump @ 6 hrs/day 722, 700 
  85W pump @ 6 hrs/day 
  15W controller @ 24 hrs/day 
  
 Refrigerant-   -  85W pump @ 6 hrs/day  229, 950 
 phase change      5W controller @ 24 hrs/day 
  
 Air-  75W pump @ 6 hrs/day 208, 050 
  5W controller @ 24 hrs/day 
  
* Pumping energy for recirculation solar systems is dependent upon the number of freeze days in 
each climate zone.  Use the value found from the following equation to determine the pumping 
energy for recirculation systems: 
 
  (Pump energy, watts x 12 x (freeze days/yr +4)) +  
     (Pump energy, watts x pump operation time, hrs x remaining days in year) +  
        (Controller energy, watts x 24 hrs/day x 365) 
  
  Where the number of freeze days per year is found in Table 1. 

 
86 

 



 
Appendix C 

 
 
The following Adjusted Standby Loss Factors were developed based on data contained in the 
Directory of Certified Water Heaters.  The table's purpose is to provide an easy reference for 
determining the adjusted standby loss rate of a particular water heater that has been externally 
wrapped with an insulating blanket of R-12.  Where blankets of lesser value are used in meeting 
the combined internal and external insulation level of R-16, as specified in Section 2-5352(i) of 
the regulations, the adjustment procedure provided in the Appendix to the regulations must be 
used.  (This appendix is not included in this manual.) Multiply the standby loss percent from the 
Directory for the given water tank capacity by the factor given below. 

 
 

 TABLE 3.  Standby Loss Adjustment 
 

 Tank Capacity (Gal.) GAS ELECTRIC 
  __________________________________________________________ 
 15-24 90 92 
 25-34 80 80 
 35-44 71 80 
 45-54 66 76 
 55-64 62 74 
 65-74 55 72 
 75-84 54 67 
 85-94 53 67 
 95 and up 50 59 
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